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Preface

This preface provides contains the following topics:

 About This Book on page 7

 Related Documentation on page 8

About This Book

This guide is intended to help you successfully deploy the ShoreTel IP Phone 930D system.

Audience

This guide is written for the person who plans for, installs, and configures the product components.

Organization

This document is generally organized into major tasks, presented in the order in which they should be 
completed.

Conventions

The following typographical marking conventions are used in this document.

Marking Meaning

Bold Names of interface objects, such as buttons and menus. 

Courier Code examples.

Courier Italic Variables in code examples.

Blue Cross references with hyperlinks. Click the blue text to go to the indicated 
section. All chapters have a list of section links on the first page. 

Note: Table of Contents entries are also links, but they are not shown in blue. 
ShoreTel IP Phone 930D Planning and Installation Guide 7



Preface Related Documentation
Related Documentation

The following documents are also available:

 ShoreTel IP Phone 930D Handset User Guide describes how to install and use the IP930D 
handset and charging stand.

 ShoreTel IP Phone 930D Base Station and Repeater User Guide describes how to plug in and use 
the IP930D base station and repeater.
8 Planning and Installation Guide ShoreTel IP Phone 930D



CHAPTER
1. Introduction

This chapter contains the following topics:

 System Overview on page 9

 Understanding System Components on page 10

 Understanding System and Coverage Limits on page 13

 Topology and Technical Specifications on page 14

 Understanding System Management on page 15

System Overview

The ShoreTel IP Phone 930D solution is a state-of-the-art DECT (Digital Enhanced Cordless 
Telecommunications) system that seamlessly adds wireless handsets to any Shoretel installation 
running ShoreTel 14 or later software.

Ideally suited for users looking for a full telephony feature set along with in-building roaming 
capabilities, the IP930D allows users to step away from their desks without losing the ability to manage 
incoming inquiries or monitor shared extensions.

Easy to deploy and use, the IP930D system offers a handset display that emulates the user interface 
of the ShoreTel IP Phone 230 models, making it familiar for many users.
ShoreTel IP Phone 930D Planning and Installation Guide 9



Introduction Understanding System Components1
The DECT frequency band means excellent voice quality and no need to worry about radio 
interference with Wi-Fi or Bluetooth devices. DECT offers highly secure communication using a 
worldwide standard of advanced algorithms for voice and data encryption, ensuring that conversation 
is protected against eavesdropping.

Understanding System Components

The IP930D system consists of these major components:

 Handset—A battery-powered mobile handset with charging stand that emulates the user interface 
of the ShoreTel IP Phone 230 models.

 Base station—A PoE-powered device containing DECT radio and processing capabilities for 
wirelessly connecting to handsets and repeaters, and for connecting over Ethernet to the IP 
network.

 Repeater—A DECT radio and processing component for extending the range of an IP930D base 
station.
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Introduction IP930D Handset1
 ShoreTel IP930D Manager—A web-based interface used for system management, including 
viewing and modifying configuration parameters, and enabling handset and repeater registration.

 ShoreTel IP930D Configuration Tool—A Windows-based program that generates required 
configuration files and an installation summary report.

IP930D Handset

The handset is powered by a replaceable lithium-ion battery and features a color LCD. The user 
interface on the handset emulates the interface of a ShoreTel IP Phone 230 model.

The handset has volume controls and a mute switch on its left side and a headset jack on its right side. 
The four bottom-most keys provide quick one-push access to the transfer, conference, redial, and hold 
features.

The handset has a built-in speakerphone for hands-free operation and can also be used with a wired 
headset.

The three line appearances can be programmed in the same way as line appearances on other 
ShoreTel IP Phones, using ShoreTel Director.

A Menu button permits access to additional system features. Hold down the Menu button for more than 
three seconds to access an internal handset settings menu.

For more information refer to the ShoreTel IP Phone 930D Handset User Guide.
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Introduction IP930D Base Station1
IP930D Base Station

The base station unit can be mounted on a desk or wall and uses an RJ-45 connector for network 
access and power.

On the front side of the unit is an operational status LED indicator. On the back side of the unit is the 
RJ-45 Ethernet connector and a reset button.

For more information, refer to the ShoreTel IP Phone 930D Base Station and Repeater User Guide.

IP930D Repeater

The repeater is an optional component used to extend the range of a base station unit. It can be 
powered by either a PoE cable or by a small wall transformer and two meter cable.

The repeater can be mounted on a wall or ceiling. On the front side is an LED indicator that shows the 
repeaters status.

For more information refer to the ShoreTel IP Phone 930D Base Station and Repeater User Guide.
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Introduction Understanding System and Coverage Limits1
Understanding System and Coverage Limits

The capacity of the IP930D system is limited by the number of DECT radio channels available in close 
proximity to the bases and repeaters.

Frequency Bands

The IP930D system uses these frequency bands:

 1920 - 1930 MHz (US)

 1880 - 1900 MHz (Europe, Australia, New Zealand)

System Capacities

Each base station and each repeater uses a 12-timeslot DECT radio.

In the US and Canada (US/CA), there are 5 frequencies available for voice: 5 x 12 timeslots = 60 
channels maximum.

In Europe, Australia, and New Zealand (EU/ANZ), there are 10 frequencies available for voice: 10 x 12 
timeslots = 120 channels maximum.

Each base station can support a maximum of 4 handsets. 

Each base can, optionally, support up to 4 repeaters. Adding repeaters does not increase the number 
of handsets that a base can support; it only extends the range, or footprint, that those handsets can 
roam.

You can daisy chain/cascade repeaters up to a maximum of three (although doing so may introduce 
delays).

Capacities (US/CA): 

 With 1 base and 0 repeaters = 4 handsets 

 With 10 bases and 0 repeaters = 40 handsets 

 Maximum combined base units and repeater units = 24 handsets (average)

Capacities (EU/ANZ): 

 With 1 base and 0 repeaters = 4 handsets 

 With 20 bases and 0 repeaters = 80 handsets 

 Maximum combined base units and repeater units = 48 handsets (average)

Capacities are limited to these maximums to ensure that all handsets can be guaranteed non-blocking 
voice paths—even when all handsets are on a three-party call.

Note that these IP930D system capacities refer to a single site or airspace within which the handsets 
are used; a single ShoreTel system can support multiple IP930D systems in different locations, so long 
as there is no airspace contention between them.
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Example of a System Layout

This example shows a four-handset IP930D system that uses one base and four repeaters.

As long as component limits for the system are honored, you could alter coverage area or capacity in 
this system to suit your needs. For example:

 If this system included daisy chained repeaters, coverage dimensions could take on different 
shapes.

 If more handsets were needed, additional bases and repeaters could be overlaid in the same 
locations as the bases and repeaters shown in the example.

For more information about designing a system layout see Chapter 2, Planning.

Topology and Technical Specifications

Each base station requires the assignment of an IP address (DHCP or static).

Each handset requires the assignment of an IP address (static). The IP addresses for handsets must 
be in a continuous range (example: 192.168.11.50 – 89).

Each handset uses the same ShoreGear switch IP Phone resources as any other ShoreTel IP Phone. 

From a resource prospective, each base can appear to be as many as four IP phones (one for each 
handset).
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14 Planning and Installation Guide ShoreTel IP Phone 930D



Introduction Call Handoff Limitations and Synchronization1
An IP930D base supports the same networking features as other ShoreTel IP phones, including 
DHCP, VLANs, LLDP, and 802.1x.

In a multi-base (multicell) environment, multicast IP packets are used to communicate among bases. 
Therefore, all bases in a single airspace should be on the same IP subnet (this avoids complex 
multicast routing configurations).

Call Handoff Limitations and Synchronization

Call handoff is not supported between base stations. Call handoff is supported across repeaters that 
are associated with the handset’s registered base station.

Because base-to-base-handoff is not supported, the maximum continuous coverage area of any 
installation will be limited to the coverage that can be obtained by using a combination of a base and its 
associated repeaters. For this reason, this system is best suited for a single air-space (such as one or 
two floors of an office building) and is not appropriate for a campus environment where handsets need 
to operate across buildings.

DECT radio synchronization is required between the bases and the associated repeaters that make up 
a system. Synchronization between bases and repeaters is done entirely over the air using DECT 
spectrum. See Synchronization on page 48 for more information.

Understanding System Management

Managing the IP930D generally requires that you use the same approach and software tools you 
would use to manage other ShoreTel IP Phones. Additionally, a web-based interface called 
ShoreTel IP930D Manager allows you to: 

 Verify and modify system configuration

 Troubleshoot issues

 Reset a base remotely

 Enable handset and repeater registration

 Check upgrade status for components

 See which components are currently in use

See Understanding System Management on page 51 of the Reference Material chapter for more 
information about ShoreTel IP930D Manager.
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CHAPTER
2. Planning

This chapter contains the following topics:

 Planning Overview on page 17

 Understanding Networking and Power Requirements on page 18

 Understanding Environmental Requirements on page 19

 Understanding Architectural Impacts to Coverage on page 20

 Gathering Site Requirements and Information on page 22

 Conducting a Site Survey on page 23

 Preparing a Draft Installation Layout on page 26

 Ordering Equipment on page 27

Planning Overview

This overview lists planning steps to complete before installing your ShoreTel IP Phone 930D system.

1. Understand system components and limitations (described in Chapter 1, Introduction.)

2. Understand networking, power, and environmental requirements (described below).

3. Understand how architectural features can impact coverage (described below).

4. Gather requirements and information specific to the installation site (described below).
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5. Conduct a site survey to measure the coverage range and identify equipment needs (described 
below).

6. Prepare a draft installation layout (described below).

7. Order components (described below).

Understanding Networking and Power Requirements

This topic contains information about network and power requirements and recommendations.

Networking Requirements and Recommendations

The following are networking requirements and recommendations:

 Assign an IP address (DHCP or static) for each base (required).

 Assign an IP address (static) for each handset (required).

 Use a switched 10 or 100 Mbps capable network connection to connect to the base 
(recommended).

 Connect multi-base systems to a common subnet and identify a free multicast address for base-to-
base communications (required).

Power Requirements 

The following are system power requirements:

 Handset charging stands require a non-switched AC outlet (100-240V 50/60 hz) within two meters 
of the charger.

 Bases are Class 2 devices and require PoE.

 Repeaters require one of these for power: 

 A non-switched AC outlet (100-240V 50/60hz) within two meters of the repeater.

 A SKU 10478 PoE wire adapter along with a PoE splitter, such as the Phihong POE14-050, for 
use with a powered Ethernet connection. (See Using a SKU 10478 PoE Wire Adapter and a 
PoE Splitter to Power the Repeater on page 19.)
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Using a SKU 10478 PoE Wire Adapter and a PoE Splitter to Power the 
Repeater

Using a SKU 10478 PoE wire adapter and a 5 Volts DC output PoE splitter, such as the Phihong 
POE14-050, allows you to install a repeater in a location that does not have a nearby AC outlet. Use 
the splitter to provide power only. Refer to the illustration below.

Understanding Environmental Requirements

Consider the following environmental guidelines when planning your IP930D installation:

 Mount bases and repeaters indoors, in dry and protected areas, and connect these components to 
indoor wiring only.

 Whenever possible, mount the base near the ceiling, vertically on the wall. Avoid mounting on 
metal walls, metal beams, or on concrete structures containing steel reinforcement.

 Bases and repeaters must be placed with at least one meter of separation between units. Range 
and system capacity might be reduced if components are located less than one meter apart.

SKU 10478 PoE wire
adapter

IP930D 
Repeater

Align “TIP” and “+”
as shown

Phihong
PoE splitter

Powered Ethernet cable plugs in here
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IP930D components emit RF radiation that is below all government and industry limits. However, some 
devices containing sensitive microphones can be affected by this radiation and should be kept at a 
distance from IP930D components.

Understanding Architectural Impacts to Coverage

Construction materials and architectural features at the installation site can greatly impact base and 
repeater coverage. In open or outdoor areas, the coverage radius of a base or repeater can be 150 
meters or more. Indoors, the distance can drop to as low as 10 meters. In addition, the base mounting 
height, nearby metal objects, and interference sources can impact coverage. 

Wall Materials

This table shows coverage ranges for some typical wall materials:

Multiple Floors

Many floor and ceiling materials allow coverage to extend to the floors above and below the base or 
repeater floor. If that proves not to be the case, find areas where repeaters can link to the base or other 
repeaters through stairwells or other openings in the building.

Wall Material Coverage Range in Meters

Plaster walls over studs 30-60

Concrete 10-30

Heavily reinforced concrete 0-10

Stone/Brick 30-50

Metal 0-10

None 150-300
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When planning multi-floor installations, it is helpful to think in three dimensions. Here is an example:

Coverage needs to overlap between floors in areas like stairwells, where handset users move between 
coverage zones while on a call. A stairway can be a good location to achieve coverage across two 
floors.

Hallways

Hallways are often good spaces for mounting base units and repeaters. For L-shaped corners, mount 
the base on the outside corner for best coverage down both hallways. The intersection of two hallways 
can also be a good location because of open transmission in multiple directions.

Multiple Buildings

Installation sites located in multiple buildings that are not within radio range of each other must be 
installed as two separate systems; handsets from one system will not operate on the other system.

B1

Front View

R1

R2

R1

Floor 2

Floor 1
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Gathering Site Requirements and Information

Make a preliminary visit to the site to gather information described in this section.

Obtain a Floor Plan

Obtain a floor plan with a distance scale and note the following items on the drawing:

 Metal walls or concrete walls greater than 1M thick

 Screen rooms

 Large metal objects, such as cabinets and machines

 Radio frequency sources, such as RF welders and WiFi

 Stairwells or similar openings where floor-to-floor transmissions might be enhanced (for multi-floor 
installations)

Identify Interference Sources

Check the customer for any pre-existing DECT use, such as a large number of DECT headsets or 
residential DECT systems. 

If possible, perform an RF analysis of the DECT band to check for interfering devices from neighbors.

Plan to disable any residential DECT systems at the time when you install the IP930D system.

Clarify Coverage Expectations 

Make sure you understand which areas of the site require coverage, including outdoor or warehouse 
spaces. Also understand if continuous coverage with handoffs is expected for multi-floor or multi-
building sites.

Because the system does not support call handoffs between bases (but only between a base and its 
repeaters), your ability to provide continuous coverage with handoffs is limited by the coverage range 
that your repeaters offer. This range varies by site and might not prove adequate for a multi-building or 
campus environment.

Consider Traffic Capacity

The IP930D system is designed to be non-blocking in most cases. However, for future reference it is 
good to understand the call frequency and talk times per hour for handset users. Consider locating a 
base in the area where the majority of users spend most of their talk time.
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Conducting a Site Survey

Before you plan your installation layout, it is essential that you conduct a site survey to measure 
handset coverage from the base station at the installation site. A site survey allows you to effectively 
estimate the equipment needed to build your system.

It is recommended that you conduct the site survey during business hours to check for competing 
DECT systems that might degrade performance of the installation.

Gather Equipment for the Site Survey

To conduct the site survey, you will need the following equipment:

 A base station configured with a static address that is otherwise in a factory default state

 A PoE mid-span power brick connected to a small Ethernet switch or hub

 A fully charged handset

Configure the Base with a Static IP Address

Before you visit the site, configure the base station that you plan to use for the site survey.

1. Put the base in a factory default mode.

a. Plug the base into a powered Ethernet switch on a live network that can allocate an IP address 
using DHCP (or use a mid-span power brick and Ethernet switch). 

b. Wait for the LED indicator to start flashing green.

c. Press and hold the reset button on the back of the base until the LED indicator turns off (at 
least ten seconds). The base resets.

2. Wait one to two minutes for the base to obtain an IP address from DHCP and to start up.

3. Open ShoreTel IP930D Manager for the base.

a. From a PC on the same subnet as the base, enter the following:

http://sd_<MAC address of base>

If this step fails, see Cannot log into a base with ShoreTel IP930D Manager on page 84.

b. Enter “admin” for the login ID and the last four digits or characters of the base MAC address 
for the password.

4. Navigate to the Network Configuration page and turn DHCP off and set the IP address to 
“192.168.123.10” and the subnet value to “255.255.255.0”.

5. At the bottom of the page click Save New Settings.

Now you can move on to positioning and powering the base at the installation site.
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Position and Power up the Base

For this procedure you will need a PoE mid-span power brick connected to a small Ethernet switch or 
hub. This equipment serves to power the base during the site survey and satisfies the base’s need to 
detect an Ethernet connection. The small Ethernet switch or hub does not need to be connected 
to a live network.

You might want to bring push pins to the site to temporarily mount the base station that you want to 
connect onto the wall.

1. Temporarily secure the base on a wall. Choose a location that is:

 Near the center of the site

 On a central floor (for multi-story buildings)

 Near the ceiling (at least 2 meters above floor level)

2. Connect the base to the mid-span power brick and Ethernet. 

Display Signal Strength on the Handset

After powering up the base, you can display the RSSI (Received Signal Strength Indicator) level on the 
handset to measure the coverage range from the base to the handset. 

Follow the steps below.

1. On a deregistered handset, press the Menu button. (If you are using a handset that is registered to 
a base, press and hold the Menu button for 2 - 3 seconds.)

The Settings Menu displays.

2. Enter *47*.

3. Highlight the matching MAC address of the base station that you are using for the site survey and 
choose Select.

The handset displays the RSSI level. For the site survey, aim to achieve a value on the handset 
that displays as 75 dBm or lower. 

Understanding RSSI Levels

The dBm value is a measurement that the system uses to report RSSI levels and is usually 
represented as a negative value. Therefore, a -40dBm signal is stronger than a -60 dBm signal. 
The handset does not display the minus sign for the dBm value. Nonetheless, the smaller the dBm 
number on the handset, the stronger the signal.

For example, here is how the handset displays an RSSI of -49dBm.
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The IP930D components function properly when RSSI levels are as follows:

 For handsets: -75 dBm or better. (This value appears on the handset as 75 or a lower number; the 
minus sign is not displayed on the handset.)

 For bases and repeaters: -70 dBm or better. (You can view levels for bases and repeaters from 
ShoreTel IP930D Manager after installation.)

Walk the Site to Measure RSSI levels

To get a sense of the average coverage range of the site, start with the base in a central location and 
walk the site (including the floors above and below the base station, if applicable) to measure RSSI 
levels from the base. Whenever construction materials vary significantly in one area of the site, move 
the base and measure again in that area. Record the results on the floor plan.

If you know the location where you are likely to install the base, measure the coverage range from this 
location, as well (for example, in the area where most handset users spent the most talk time).

Wherever the handset RSSI level reads higher than 75 dBm, you have moved out of performance 
range. In this case, you might need to add one or more repeaters to achieve adequate coverage for 
the site. Record these locations on the floor plan.

Identify Repeater Locations (if applicable)

Follow these steps:

1. On the floor plan, note the edge of the base station signal range (where the handset RSSI value 
reads higher than 75 dBM). You can assume that you will need to install a repeater at this location.

2. Move the base to a location near this reference point and measure the handset range from the 
new location.

3. Repeat if needed, recording repeater locations and RSSI levels on the floor plan.
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Preparing a Draft Installation Layout

Using the coverage range measurements from your site survey, estimate base and repeater layouts 
that are likely to provide a value of 75 dBm RSSI or lower everywhere that handset coverage is 
required.

The purpose of the draft layout is primarily to order equipment for installation. Determining the exact 
location of the base and repeaters can only be approximated at this stage. The layout can be fine-
tuned when you perform the final equipment installation.

Keep in mind:

 Each base station supports as many as four handsets.

 Each base station supports as many as four repeaters.

 You can daisy chain as many as three repeaters, although doing so can introduce delays.

 To increase the number of handsets for your system, you can overlay additional bases and 
repeaters at a location where you have already successfully installed a base and repeaters. 
However, the total number of handsets must be within system limits and components must be 
spaced at least one meter apart. See Understanding System and Coverage Limits on page 13.

Draft Installation Layout—an Example

This system uses multiple bases and associated repeaters to support 12 handsets
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In the illustration, solid outlines represent the -70 dBm RSSI contours for each group of bases and 
repeaters; dashed lines show the repeaters associated with each base.

A base and its connected repeater (or a repeater connected to another repeater) should be near the 
-70dB RSSI contour of the base or repeater to which it is connected. It is good to be conservative to 
avoid underestimating the required equipment.

The equipment order for this example consists of three bases, 12 repeaters, and 12 handsets.

Ordering Equipment

After completing the steps described in this chapter, you can determine the equipment that you need to 
order. Consider if users require extra equipment, such as wired headsets or additional handset 
charging stands.

Once you have the necessary equipment, complete the steps in the Installation chapter.
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CHAPTER
3. Installation

This chapter contains the following topics:

 Installation Overview on page 29

 Creating Configuration Files on page 30

 Registering Handsets and Repeaters to Bases on page 31

 Performing a Site Survey to Confirm Coverage on page 34

 Finalizing Installation on page 36

Installation Overview

Once you obtain ShoreTel IP930D equipment, complete the tasks described in this installation 
overview. For more information about each step, see the topics that follow.

1. Use the ShoreTel IP930D Configuration Tool to create base-specific configuration files.

2. Store the configuration files on the FTP server in the same directory where the standard IP phone 
configuration files are located.

3. Register handsets and repeaters with their associated bases.

4. At the installation site, temporarily install a base and its associated repeaters at a location 
specified in your draft installation layout.

5. Perform a site survey to check that handset RSSI levels are -75 dBm or better in the areas 
requiring coverage. Adjust locations or add repeaters, as needed.
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6. If needed, add bases and repeaters in new or existing locations, repeating the site survey for each 
addition.

7. Permanently install equipment at the site.

8. Assign user extensions and distribute handsets and charging stands.

Creating Configuration Files

Use the ShoreTel IP930D Configuration Tool to generate the required configuration files.

Prepare to Use the Configuration Tool

Before you use the ShoreTel IP930D Configuration Tool, complete these preparation tasks:

1. Gather the following unique identifiers from your IP930D equipment: 

 For each base, note the MAC address (located on the rear label).

 For each handset, note the IPUI (located under the battery). 

 For each repeater, note the IPEI (located on the rear label).

2. Have ready the number of repeaters per base and the total number of handsets used by the 
system.

3. Reserve static IP addresses for handsets in the IP930D system prior to deploying. Consider 
reserving an adequate range of addresses to allow for future growth.

Create and Install Configuration Files

Use the ShoreTel IP930D Configuration Tool to prepare MAC-specific configuration files for each base. 
Load the files onto the FTP server in the same directory as the standard IP phone configuration files. 
The configuration files should be prepared prior to the installation visit.

Note

To simplify installation and debugging procedures, it is good practice to check that hard-wired 
phones are working properly and install/test any common equipment prior to installing the IP930D 
components.

Note

Option 156 is used in the bases to ensure that they download the required files. Make sure that 
option 156 is configured on the DHCP server.
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Follow these steps:

1. Run the IP930D Configuration Tool and follow the wizard to enter the necessary information.

For screen-by-screen instructions, see Appendix A, Installation Example.

2. Save the project to your computer. If you need to replace or add equipment, you can start from this 
project file.

3. Save the MAC-specific configuration file for each base station and install these files on the FTP 
server in the same directory as the standard IP phone configuration files. To do this, choose File > 
Save Configuration Files As and select the \\Inetpub\ftproot folder on the FTP server. (These 
instructions assume that you are running the IP930D Configuration Tool from the HQ server.)

4. Choose File > Print Installation Summary to print the installation summary. Save a copy to use 
during installation of the equipment and for future reference.

The installation summary indicates which devices need to be installed where, and which handsets 
and repeaters are associated with each base. It also shows the RPN (radio fixed part number) 
assignment for each base and repeater. The RPN identifier is used by ShoreTel IP930D Manager 
and can be useful when troubleshooting. 

Registering Handsets and Repeaters to Bases

The next step is to register handsets and repeaters to their associated bases. 

Registration Checklist

Before beginning registration, review this checklist to make ensure you are well prepared:

 Has a planning site survey been performed and a draft installation plan created for locating bases 
and repeaters?

 Have the MAC-specific configuration files been prepared for each base in the system? Have those 
files been loaded onto the ShoreTel FTP server in the same directory as the standard IP phone 
configuration files?

Note

If you do many installations, it may be worth investing in a bar code scanner to read the MAC 
address and other identifiers from the IP930D components. This can reduce data entry errors that 
can cause system malfunctions.

Note

A factory fresh base station is locked initially. After you enable it for handset and repeater registration, 
the base station stays open for 10 minutes. If registration takes longer than this 10 minute window, the 
base station shuts down and you must unlock it again.
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 Have static IP addresses been reserved for all of the handsets, including extra capacity for future 
growth?

 If 802.1x is being used, has authentication been configured for each base on the Ethernet 
switches and/or RADIUS (Remote Authentication Dial In User Service) servers?

 Is a common subnet available for all bases to share?

 Have arrangements been made for providing power to repeaters?

 Is option 156 configured on the DHCP server to ensure that the bases will download the required 
files?

 Is the MAC address written down for each base station? (The MAC address is located on the rear 
label of the base station.)

Registering Handsets

Before you begin registering handsets, note the following: 

 Be sure registration is enabled on only one base at a time so that you register repeaters and 
handsets to the intended base.

 If your system uses multiple bases, the first base you configure must be the one designated RPN 
0. Refer to the installation summary to identify the MAC address of the base with this designation.

 If you are attaching the base to an 802.1x secured network, you must pre-configure security 
credentials in the base before Registering the handsets and Repeaters. See Configuring Bases on 
a Network Secured with 802.1x on page 70.

To register handsets, follow these steps:

1. Factory clear the base.

a. Plug the base into a powered Ethernet switch until the LED indicator starts flashing green.

b. Press and hold the reset button on the back of the base for at least 10 seconds or until the 
LED indicator turns off. 

The base resets and downloads configuration file(s) and any software upgrades. This can take 
several minutes. The process is finished when the green LED on the base turns steady green. 
Do not proceed to the next step until the LED is steady green. 

2. Wait one to two minutes for the base to obtain an IP address from DHCP and start up.

WARNING!

Never unplug a base while its LED indicator is flashing red or it may be permanently 
damaged.
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3. Open ShoreTel IP930D Manager for the base. 

a. From a PC on the same subnet as the base, enter the following:

http://sd_<MAC address of base>

If this step fails, see Cannot log into a base with ShoreTel IP930D Manager on page 84.

b. Enter “admin” for the login ID and the last four digits or characters of the base MAC address 
for the password.

4. From the Base Security page, turn on Handset/Repeater Registration and save the settings.

5. Turn on each handset associated with this base. (You can turn on all of the handsets at once.)

6. On the handset, choose Menu > Connectivity > Register/Deregister and enter the Handset 
Registration code “0000”. Press the OK softkey.

The handset displays the idle screen after successfully registering and contacting the switch.

7. If you are registering repeaters, continue on to the topic below. Otherwise, disable Handset 
Registration in the Base Security page of ShoreTel IP930D Manager and save the settings.

Registering Repeaters

After registering handsets, register any repeaters that are associated with the base. (You can skip this 
step if your system does not include repeaters). 

Before you begin: Confirm that Handset/Repeater registration is still active on the Base Security page 
in ShoreTel IP930D Manager. This state is indicated by a blinking green/red LED on the base station.

1. Plug in a repeater. Make sure it is near the base you are registering to.

Note

If you have daisy chained repeaters, always start by registering the repeater that is connected to the 
base. Leave all repeaters on until the last one is registered.
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2. Perform a factory reset of the repeater.

Press and hold the reset button on the repeater for about 3 seconds until the LED turns solid red, 
then release the button. Wait for the green LED to start double flashing.

Within one minute the repeater should register with the base and the green LED should turn green 
steady.

3. Repeat steps 1 and 2 for the remaining repeaters associated with this base. Be sure registration is 
enabled on only one base at a time so that you register repeaters and handsets to the intended 
base.

4. When you have finished registering all repeaters, disable Handset Registration from the Base 
Security page of ShoreTel IP930D Manager and save the settings.

Performing a Site Survey to Confirm Coverage

After temporarily locating one base and its repeaters at the locations specified in the installation plan, 
perform a site survey to check coverage.

Follow these steps:

1. Turn on one of the handsets registered to the base and make sure it powers up and shows the idle 
screen.

2. Open ShoreTel IP930D Manager for the base.

a. From a PC on the same subnet as the base, enter the following:

http://sd_<MAC address of base>

If this step fails, see Cannot log into a base with ShoreTel IP930D Manager on page 84.

b. Enter “admin” for the login ID and the last four digits or characters of the base MAC address 
for the password.

3. Go to the Manage Bases page and scroll to the “Repeater reported RSSI Information (dBm)” table 
at the bottom of the page.

4. Look for RSSI values highlighted in red. A red highlighted value indicates a repeater that is 
receiving an insufficient signal (-75 dBm or a greater negative number) from its upstream device 
and must be moved closer. It may take up to 15 minutes after you move a repeater for its signal to 
be updated.

See the Understanding Repeater RSSI Levels on page 35 for more information on interpreting the 
RSSI table.

5. Enter the site survey mode on one of the handsets by pushing the Menu button for more than 3 
seconds (the Settings menu appears), then typing *service* (*7378423*) on the key pad.
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An overlay displays the RPN of the base or repeater the handset is connected to (left-most) and 
any other base or repeaters it can see. The RSSI of the base or repeater the handset is connected 
to is also shown. See Handset Service Menu on page 79 for a more detailed look at site survey 
mode. 

6. Press End/Power on the handset to exit the Settings menu. 

7. Place a test phone call to a wired phone to check audio performance as you move about the site.

8. Walk the complete coverage area to verify an adequate signal in all locations over the desired 
area.

9. Make adjustments as necessary to the repeater and base locations until satisfactory coverage is 
available.

10. Turn off the site survey mode on the handset by pushing End/Power to turn off the handset.

Understanding Repeater RSSI Levels

Here is an example to help you understand how to interpret the “Repeater reported RSSI Information 
(dBm)” table for a base and its repeaters. This table is found in the Manage Bases page in ShoreTel 
IP930D Manager.

These tables use the RPN assignments from the installation summary to identify repeaters and bases. 
The repeaters reporting information are listed by RPN in the left column. The 2nd column shows the 
base RPNs, followed by any repeaters on the system.

Here is what we can interpret from example table, above:

 The repeater with RPN 0x21 sees a signal level of -75 dBm from the base with RPN 0x20.

 The repeater with RPN 0x22 sees a signal level of -71 dBm from the base with RPN 0x20 and 
-75dBm from the repeater with RPN 0x23.

 The repeater with RPN 0x23 sees a signal level of -96 dBm from the base and -71 dBm from the 
repeater with RPN 0x22.

Keep in mind that repeaters need to receive adequate signals from their upstream synchronization 
source only. The repeaters in this example with RPN 0x21 and 0x22 have the base as their source. 
Repeater 0x23 uses the repeater with RPN 0x22 as it upstream source, and not the base. Therefore, 
the -96 dBm level reported for the base at RPN 0x20 is not important.

A red entry in the table indicates that the signal is too low and the repeater must be moved closer to its 
synchronization source. The level to aim for is -75 dBm or better. 
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Finalizing Installation

Finalizing installation includes overlaying additional bases and repeaters, permanently installing 
equipment, and assigning user extensions.

Installing Additional Bases

Depending on your coverage and capacity needs, you might choose to overlay additional bases and 
repeaters at the same location as your initial installation to increase the number of handsets supported 
in that area. Keep in mind that the total number of handsets your system supports is limited. (See 
Understanding System and Coverage Limits on page 13.)

When you are installing multiple bases, be sure to install one base and its associated repeaters 
completely before installing the next base. This means repeating the site survey for each base and its 
associated repeaters individually before making the installation permanent. For an example of an 
installation of this scale, see Appendix A, Installation Example.

When installing more than one base, keep the following in mind:

 For systems with more than one base, the first base you configure when registering handsets and 
repeaters must be the base designated RPN 0, as indicated by the Installation Summary.

 Each base will require a dedicated PoE switch port and each repeater will require a power source.

 Each base and repeater must be separated by at least 1 meter for proper performance.

Assigning User Extensions

The last step for finalizing installation is to assign user extensions to the IP930D handsets using the 
ShoreTel Director interface. The procedure for doing this for IP930D devices is the same as for any 
other ShoreTel IP Phone. 

You or your system administrator must distribute, and possibly install, handsets and charging stands to 
users. Be sure to deliver product documentation, as well. See Related Documentation on page 8.

Note

 It can take up to 15 minutes after moving a repeater before updated signal strengths are reported in 
ShoreTel IP930D Manager. You must refresh the web page to see updated RSSI values.

 The dBm value is a measurement used to report RSSI levels and is usually represented as a 
negative value. A -40 dBm signal is stronger than a -60 dBm signal. However, unlike the IP930D 
Manager, the IP930D handset does not display the dBm value with a minus sign.

Tip

In ShoreTel Director, IP930D handsets display a MAC address that begins with “02” and ends with the 
IPUI of the handset.
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CHAPTER
4. Maintaining Your System

This chapter contains the following topics:

 Replacing a Handset on page 37

 Replacing a Repeater on page 40

 Replacing a Base on page 40

 Adding a new Base and Handsets on page 41

 Updating IP930D Firmware on page 46

Replacing a Handset

To replace a handset, follow this procedure. 

1. In the ShoreTel IP930D Configuration Tool, load the saved *.XML project file for the existing 
installation by choosing File > Open Project. 

Note

Make sure the file is up to date and matches the installed configuration or you will cause the 
system to stop working when you apply the files it generates.
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For this example, we will open the project file that we created in Appendix A, Installation Example, as 
shown below.

2. To replace a device, first click on that device and enter the new identifier, as appropriate. 

For this example, we will replace the handset with IPUI 016E6003C3 with a new handset with an 
IPUI of 016E6003F1. To do this, first select Base1 in the left pane, then select the handset with 
IPUI of 016E6003C3 in the center window.
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3. In the Handset Properties in the right pane, enter the new IPUI for the handset you are replacing, 
as shown below.

4. Choose File > Save Project As to save the new configuration with a new filename.

5. Backup the existing MAC-specific configuration files for all bases before proceeding. You might 
need to restore these files if you encounter problems later.

6. Generate new MAC-specific configuration files by choosing File > Save Configuration Files As. 
Save these to the FTP root directory for the system, or to a temporary location where you can copy 
the files to the root directory later.

7. Reset the base on which the handset is located using ShoreTel IP930D Manager. To do so, go to 
the Reset Base page in ShoreTel IP930D Manager, check Reset Base, and click Reset.

The base restarts and downloads the updated configuration file.

8. After the LED indicator on the base has turned steady green, enable registration for the base with 
the new handset using ShoreTel IP930D Manager from the Base Security page.

9. On the new handset, choose Menu > Connectivity > Registration. Enter the Handset 
Registration code “0000” and press the OK soft key. 

The handset should now be operational and a user can be assigned.
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Replacing a Repeater 

The procedure for replacing a repeater is similar to that for a handset (see above), except that you 
must enter the IPEI value for the new repeater in the Repeater Properties area of the applicable web 
page in the ShoreTel IP930D Configuration Tool.

After backing up the old MAC-specific configuration files and after the new ones have been placed into 
the FTP root directory, reset the base on which the repeater is located using the Reset Base page of 
ShoreTel IP930D Manager. This will cause the base to restart and download the updated configuration 
file.

Next, enable registration for the base with the new repeater using ShoreTel IP930D Manager from the 
Base Security page and plug in the new repeater at its installation location. Press and hold the reset 
button on the repeater for about 3 seconds until the LED turns solid red and then release the button. 
Wait for the green LED to start double-flashing. Within one minute the repeater should register with the 
base and the LED should turn green steady, indicating it is operational.

Replacing a Base 

The procedure for replacing a base is similar to that for a handset (see above) except that you must 
enter the MAC address for the new base in the Base Properties area of the applicable web page in the 
ShoreTel IP930D Configuration Tool.

After the updated MAC-specific configuration files have been placed into the FTP root directory, all 
bases in the system need to be reset in order to learn about the new base. For each base, go to the 
Reset Base page in ShoreTel IP930D Manager, check Reset Base, and click Reset. Continue until all 
bases have been reset.

Replacing the Base designated RPN 0x00

When the base designated RPN 0x00 is replaced, all repeaters and handsets in the system need to be 
re-registered with their respective bases. This base has an RFPI (Radio Fixed Part Network Identity) 
that is used system-wide for authentication; if this RFPI changes without re-registering components, 
authentication of all handsets and repeaters in the system will fail.

If the base you are replacing is not RPN 0x00, you can disregard this section.

You can see which base in the system has been designated RPN 0x00 by looking at the installation 
summary. If your system has only one base, this base is always RPN 0x00. 

To replace the base designated RPN 0x00, follow the instructions for Replacing a Base on page 40. 
However, when resetting bases from the Reset Base page of ShoreTel IP930D Manager, start with the 
base at RPN 0x00. Otherwise, the system will not operate properly.

Note

If you are replacing the base designated RPN 0x00, be sure to read the section below for special 
procedures. You can find RPN assignments in the installation summary.
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After all bases have restarted, reregister all of the handsets and repeaters with their respective bases 
(these relationships are specified in the installation summary). To do this, enable registration on one 
base at a time using ShoreTel IP930D Manager from the Base Security page.

To register handsets, choose Menu > Connectivity > Registration. Enter the Handset Registration 
code “0000” and press the OK soft key. 

Repeaters must be re-registered starting with the repeaters directly connected to the base and working 
outward, if any are daisy chained. 

Press and hold the reset button on the repeater for about 3 seconds until the LED turns solid red and 
release the button. Wait for the green led to start double flashing. Within one minute, the repeater 
registers with the base and the green LED turns green steady, indicating that it is operational.

Adding a new Base and Handsets

To add a new base and additional handsets to the system, follow these steps.

1. Load the project file for the existing installation by choosing File > Open Project in the ShoreTel 
IP930D Configuration Tool. For this example, we can open the project file we created previously. 

Note

Keep in mind that the handset registration mode only stays enabled for about 10 minutes. If 
registration takes longer, you must re-enable registration mode before proceeding.
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In the right hand pane, you can modify the static IP address range available to assign to handsets. 
If the range is insufficient, leave the starting address as-is and extend the range. In this case, nine 
addresses are available and therefore no such action is required.

2. In the left pane, click Add base.

3. Select the new base in the left pane.

4. Enter the MAC address of the new base in the Base Properties area, as shown below.

5. To add a repeater to the base, click Add repeater in the left pane. A window opens asking you to 
select a repeater. 

6. Choose New repeater and OK. A new repeater is added. 

7. Add the IPEI of the new repeater in the Repeater Properties area.
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In the example below, the procedure was repeated for two more two repeaters, for a total of three new 
repeaters.

8. The next step is to make sure the synchronization source for each repeater matches that used by 
other bases in the system. Do this by selecting one of the existing bases in the left pane and noting 
the sync source for each repeater. 
ShoreTel IP Phone 930D Planning and Installation Guide 43



Maintaining Your System Adding a new Base and Handsets4
For example, Base 1 is selected below.

Note that Region A and B bases are synced to the Base, but region C is synced to the repeater in 
Region B. We need to match this arrangement for the new repeaters. 
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To do this, choose the IPEI for the Region B repeater from the drop-down list under Synchronization 
source for the repeater serving Region C on Base4, as shown below.

9. Add new handsets to this new base. In this example, we will add two new handsets. Begin by 
making sure you have Base4 selected and then click Add handset in the left pane. A new window 
opens. 

10. Click Add New and then click OK. Enter the IPUI for the new handset in the Handset Properties 
area. 

11. Repeat the procedure for the 2nd handset.

12. Save the modified configuration using a new file name by choosing File > Save Project As. 

13. Print the system configuration by choosing File > Print Installation Summary. Keep this on hand 
for future reference.

14. Generate new MAC-specific configuration files by choosing File > Save Configuration Files As. 
Save these to the FTP root directory for the system or to a temporary location where you can copy 
them to the ftproot directory later.
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15. After backing up the old MAC-specific configuration files, and after the new ones have been placed 
into the FTP root directory, you must reset all bases in the system. Starting with the base assigned 
to be RPN 0x00 and proceeding one base at a time, reset bases from the Reset Base page in 
ShoreTel IP930D Manager.

16. After all bases have restarted, plug in the new base and re-register all of the handsets and 
repeaters to the new base as specified in the installation summary. To do this, enable registration 
on the new base using ShoreTel IP930D Manager from the Base Security page. On the handsets, 
choose Menu > Connectivity > Registration. Enter the Handset Registration code “0000” and 
press the OK soft key.

17. Finally, register the repeaters to the new base starting with the repeaters directly connected to the 
base and working outward, if any are daisy chained. Keep in mind that the handset registration 
mode will only stay enabled for about 10 minutes; if it takes longer than 10 minutes to register all 
handsets and repeaters, you must re-enable registration mode before proceeding.

Updating IP930D Firmware

You can update the firmware for all of the IP930D components associated with a base station system 
by using one of these methods: 

 From ShoreTel IP930D Manager—Reset the base from the Reset Base page. This is the 
recommended method. ShoreTel IP930D Manager allows you to see if any devices are in use 
before resetting the devices and displays upgrade progress. See Resetting and Factory Clearing 
the Base Station on page 56.

 From ShoreTel Director—Search for and then update/reboot all of the IP930D handsets from the 
Diagnostics & Monitoring page. Be aware that resetting a handset from Director also resets the 
hosting base and all other handsets used by that base. Calls in progress will be dropped.

 From a registered IP930D handset—Perform a Mute+RESET by pressing the Mute button and 
typing the word “RESET” on the handset key pad. Taking this action resets the associated hosting 
base station. Other handsets and/or repeaters associated with the same base will reset 
automatically if firmware updates are needed. (If you have a multicell system and do not know 
which base the handset is associated with, you may want to use an alternate method to update 
firmware.)

WARNING!

If you do not start with the base at RPN 0x00, the system will not operate properly.

Note

 Power-cycling a handset will not trigger a handset firmware upgrade (if available); only a base 
station reboot/reset will trigger the system to check for firmware updates.

 Handset and repeater updates are performed over the air and can take between 30 minutes to 
3 hours. The Current Status page in ShoreTel IP930D Manager displays upgrade progress for 
each component. For more information, see Understanding System Software Upgrades on 
page 50.
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CHAPTER
5. Reference Material

This chapter contains the following topics:

 Theory of Operation on page 47

 Synchronization on page 48

 Understanding the DECT Registration Process on page 49

 Understanding System Software Upgrades on page 50

 Understanding DECT Registration Security on page 51

 Understanding System Management on page 51

 Understanding Configuration Parameters on page 61

 Configuring Bases on a Network Secured with 802.1x on page 70

Theory of Operation

The ShoreTel IP930D base appears to the MGC (Media Gateway Controller) to look like as many as 
four independent ShoreTel IP Phone 230 models. Each IP930D handset has a unique MAC address, 
achieved by adding a “02-” prefix to the handset’s IPUI number.The primary IP address of the base 
may be statically configured or obtained using DHCP and assigned to one handset. The remaining IP 
addresses must be configured using the DectHandset configuration parameter.

Each base is limited to supporting four handsets; this limit ensures non-blocking service to all handsets 
(when all handsets are on independent three-way calls).

IP 230 MGCP signaling received by the base from the MGC is translated by the base to a format the 
IP930D handsets can understand; in the opposite direction, the base translates DECT signaling into 
MGCP. Each handset on the base is handled independently. 
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Each handset will use the MGCP endpointID of “SHOR_aabbccddeeff@www.xxx.yyy.zzz” where 
aabbccddeeff is the 40-bit IPUI of the handset (extended to 48-bits by pre-pending the value 0x02 in 
hex format) and www.xxx.yyy.zzz is the handset IP address. On an IP 230, the phone’s MAC address 
is used for the aabbccddeeff field. (ShoreTel Director uses the endpoint ID reported by the MGCP 
RSIP sent by the base.)

When managing IP930D handsets in Director, the IPUI of the handset (found on a label under the 
battery or accessible from the Setup Menu) can be used to link physical handsets to the information in 
Director. An IP930D handset with an IPUI of 116E5001FB will be reported by Director to have a MAC 
address of 02116E5001FB (pre-pended 02).

Synchronization

This section contains information about synchronization.

Call Handoffs and Synchronization

Although call handoffs between bases are not supported in the system, handoffs do occur between a 
base and its repeaters.

When more than one base is used to create a system, it is called a multicell system. To maximize the 
channel capacity in such a system, it is necessary for all bases and repeaters in the system to be 
synchronized with each other. Synchronization is also required for seamless handoffs between the 
base and its repeaters.

The IP930D system uses over-the-air synchronization and syncing relationships between bases will be 
determined automatically by the system. This method is preferred because it improves reliability over a 
manual static configuration that cannot adapt to propagation changes or equipment failures.

The syncing relationship for repeaters is simple and a static manual configuration must be used.

All bases in a multicell system must be assigned the same DectSysChainId. In the unlikely event that 
multiple multicell systems are sharing the same subnet (or multicast forwarding is enabled between 
different subnets) they must each be assigned a unique ID (this could happen if a subnet covers a very 
large area and two independent and spatially distant multicell systems are installed that share the 
same subnet or multicast domain.)

Understanding DECT Synchronization Modes

DECT uses a radio protocol “Multi Carrier, Time Division Multiple Carrier, Time Division Duplex” or 
MC/TDMA/TDD. This provides a total of 60 duplex channels in the US and Canada and 120 duplex 
channels in other regions. To achieve this channel usage, all bases and repeaters in a system need to 
be synchronized in the time domain. Synchronization is also required for handovers between bases 
and repeaters.
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IP930D bases can automatically configure themselves to identify the hierarchy of synchronization 
relationships on a dynamic basis using wireless links. These relationships can be observed using 
ShoreTel IP930D Manager on the Manage Bases page. Repeaters must have their synchronization 
relationships assigned using the DectRepeaterSyncSrcRpn configuration parameter.

For bases or repeaters to synchronize with each other wirelessly, they must be in range of each other. 
A maximum of 7 sync levels may exist between the synchronization master (always one of the bases) 
and the last base or repeater in the sync chain. For example:

In this installation, Base B1 is the sync master. Bases B2, B3, and Repeaters R1 and R2, are at sync 
level 2. Repeater R3 is at sync level 3 and Repeater R4 is at sync level 4. In most cases, it is desirable 
to have the sync master located in the center of the coverage area to create the most flexible sync 
chain arrangement. When automatic synchronization is used the base master can change over time as 
determined by the system. Having more than one base within sync range permits the system to 
establish sync paths around base failures.

Understanding the DECT Registration Process

Handsets and repeaters are authorized to access the system once they are registered with a base. 
The overall process looks like this:

1. During startup, the base downloads its MAC-specific configuration file that contains DectHandset 
and DectRepeaterIpei parameters. The IPUI and IPEI values in these parameters are used to build 
a white list of devices that are permitted to register with the base.

2. From the Base Security page in ShoreTel IP930D Manager, handset registration is enabled. 
Registration will be automatically disabled after 10 minutes.

3. On the handset, push the Menu button and select Connectivity followed by Register.

4. Enter the appropriate access code (0000).

5. On the repeater, press and hold the reset button for 3 seconds until the LED indicator turns red; 
the repeater registers.

Registration is required before a handset attempts to register with the switch (and show up in Director).

R1 R2

R3 R4

B1

B3

B2
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If a handset is deregistered (or powered off), it does not attempt to register with the switch and will stop 
responding to all communications from the switch; in this case, calls to the handset go to call 
coverage, such as a voicemail box.

Understanding System Software Upgrades

When the base first starts running, system software is automatically checked to see if it is up to date. If 
a newer version of software is found on the FTP server, it is downloaded to the base. Base firmware is 
upgraded prior to the start of system operations. Base updates can take up to 5 or more minutes to 
complete depending on how many software elements are upgrading.

Handset and repeater updates are performed over the air and in the background of normal system 
operations. Handset and repeater upgrades can take up to 3 hours or more depending on the activity 
of the system. Transmission of the upgrade is halted during phone calls to minimize the impact of the 
transmission on the operation of the system.

The status of all upgrades can be monitored from the Current Status page in ShoreTel IP930D 
Manager (last column).

For handsets, the update status passes through these states: Percentage (%) Copied, Complete, 
Checked, Complete, Charge Handset, and Complete.

For repeaters, the update status passes through these states: Percentage (%) Copied, Checked, 
Restarted, and Complete.

Handsets are not upgraded until they are returned to the charging stand; this ensures that adequate 
battery life is available to complete the upgrade once it begins. 
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When a handset is returned to the charging stand, the LED indicator at the top of the handset shows 
the progress of the upgrade:

1. Slow green flash after the handset is first placed into the charger for about 90 seconds—Checking 
the transferred image for errors.

2. Fast green flash for about 60 seconds—Writing image to Flash.

3. Amber flash for about 30 seconds—Verifying image.

4. Red flash for about 10 seconds—Clearing downloaded image.

5. Handset restarts and shows the idle screen after a few seconds.

Repeater upgrades are completely automatic.

Understanding DECT Registration Security

White lists are used to limit the handsets and repeaters that may register with a given base. For bases, 
the DectHandset parameter is placed in a MAC-specific configuration file associated with a base to 
limit what handsets can register with that base. The DectHandset parameter also assigns an IP 
address for each handset.

Similarly, the configuration parameter DectRepeaters is used to limit the repeaters that may register 
with a given base. For repeaters, the DectRepeaters parameter is placed in a MAC-specific 
configuration file associated with a base to limit what repeaters may register with that base. 

Both handsets and repeaters use the registration code 0000. (You do not need to enter a registration 
access code for repeaters; repeaters use 0000 automatically). 

Understanding System Management

The IP930D system is primarily configured using downloadable configuration files, similar to the 
ShoreTel IP Phone 230. However, the base and repeaters have special configuration needs that 
require a browser-based interface called ShoreTel IP930D Manager.

WARNING!

Never remove a handset from the charging stand during the upgrade process, which takes 
approximately four minutes. If the battery condition is marginal, the upgrade may not complete 
properly if the handset is removed prematurely.
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Using ShoreTel IP930D Manager

The IP930D base provides a web server on port 80 of the primary IP address of the base to create the 
ShoreTel IP930D Manager interface. ShoreTel IP930D Manager is required because certain 
procedures, such as registering a handset, require handset registration to be temporarily enabled.

To access ShoreTel IP930D Manager: 

1. From a PC on the same subnet as the base, enter the following:

http://sd_<MAC address of base>

If this step fails, see Cannot log into a base with ShoreTel IP930D Manager on page 84.

2. Enter “admin” for the login ID and the last four digits or characters of the base MAC address for the 
password.

From one base, you can click links on the Manage Bases page to quickly switch to other bases in the 
system.

Web access is password protected using digest authentication as defined in RFC 2617. The password 
can be changed on the Base Security page.

A brief overview of each page in ShoreTel IP930D Manager follows.

Note

Although many parameters can be modified from ShoreTel IP930D Manager, it is highly 
recommended that configuration files be the primary method for setting and changing parameters.
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Viewing Current Status

The Current Status page shows an overview of the system. It is useful to perform a quick check on 
how the base is configured, the software versions in use, and which handsets and repeaters are 
attached.
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Viewing and Configuring Network Settings

The Network Configuration page shows the current network settings of the base and provides a way to 
manually configure values for the IP address, Subnet Mask, and Gateway that cannot be set using a 
configuration file.
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Enabling Registration and Changing Your Password

The Base Security page allows you to enable handset and repeater registration, view handsets and 
bases that are registered in the base, and modify the base’s IP930D Manager password from its 
default (the last 4 digits of the base’s MAC address).
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Resetting and Factory Clearing the Base Station

Use the Reset Base page to reset the base station (allowing for firmware updates as needed on all 
associated system components) or to return the base to factory default settings.

You can also perform a “Mute Clear,” which does the following:

1. Turns on DHCP.

2. Erases the DHCP cache.

3. Sets the DHCP SiteOption to the default value of 156.

4. Clears the MGCP IP cache.

5. Sets the 802.1x cached login and password to be “” and stops the 802.1x supplicant if it is running.

6. Resets the base.
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Managing Bases

The Manage Bases page can be used to manage many properties of the system, particularly those 
related to multicell operation. The “Base units in System” list has a rich set of information about each 
base in the system.

The graphic below shows the top portion of the Manage Bases page.

Refer to the sections below for more information about specific areas of the Manage Bases page.

Table 1—Base Units in System

This table lists all base units in the system.
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The columns in this table provide the following information:

1. ID—Index of all bases from 0 to N for this table.

2. RPN—Radio Fixed Part Number (0x00 to 0xff) assigned to each base.

3. Base Version—Base firmware version.

4. MAC Address—MAC address of base.

5. IP Address—Hyperlink of the IP address of base (links to that base’s management page).

6. IP Status:

 This unit—If this is the unit being managed.

 Connected—If communications with this base are working.

 Connection Lost—If communications to this base are not working.

7. Sync Source—The RPN that is the synchronization source for this base. These are automatically 
assigned by the system.

8. Sync Property:

 Primary—Base station to which all other nodes are under in the sync hierarchy.

 Locked—Base is locked to the base that is its master (shown in sync source).

 Searching—Looking for a sync source.

 Free Running—Base that has lost its sync.

 Unknown—State of sync is unknown (usually because IP Status is in Connection Lost state).

9. Base Name—Name assigned to this base using the BaseName configuration parameter within the 
ShoreTel IP930D Configuration Tool.

Table 2—Base reported RSSI Information

The Base reported RSSI Information (dBm) table shows the RSSI values that are being received by 
every base from every other base. This can be used to make sure bases are located within range of 
each other and/or are operating properly from a radio perspective. RSSI levels that are too low are 
highlighted in red.
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Table 3—Repeaters on this Base

The Repeaters on this Base table shows a list of all repeaters associated with this base and their 
status.

The columns in this table provide the following information:

1. ID—Index of all bases from 0 to N for this table.

2. RPN—Radio Fixed Part Number (0-255) assigned to each base.

3. Version—Base firmware version.

4. IPEI—International Portable Equipment Identity, the unique identifier for the repeater.

5. Sync Source—The RPN of the base or repeater that is the synchronization source for this 
repeater. Repeater synchronization sources are assigned using the ShoreTel IP930D 
Configuration Tool.

6. Status:

 Present—The repeater is working and in contact with the base. It may take up to 60 minutes 
for this status to be correctly shown after making changes or starting the system.

 Unknown—The repeater is not in communications with the base and its status is unknown.

Table 4—Repeater Reported RSSI Information

The Repeater reported RSSI Information (dBm) table shows the RSSI values that are being received 
by all repeaters on the base. This can be used to make sure repeaters and/or bases are located within 
range of each other. RSSI levels that are too low are highlighted in red. See Understanding Repeater 
RSSI Levels on page 35.
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DECT Synch Chain

The DECT Sync Chain area on the Manage Bases page shows the hierarchy of synchronization 
relationships among bases in the system. This hierarchy is automatically created and managed by the 
system.

Viewing Configuration Data and System Logs

The Configuration and System log pages are used for debugging the system. The configuration data 
shows the settings that the base is currently using. This can be examined to see if it agrees with the 
desired configuration.

The System log shows the same information that is sent to the Syslog server and is used primarily for 
debugging. The debug levels used by this log can be set using the SysLogInfo parameter. This log will 
show the last 50,000 characters that have been sent.
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Using ShoreTel Director to View and Reset Handsets

IP930D handsets appear in the IP Phone List in Director as individual IP phones with the model 
number IP930D.

Caution must be exercised when remotely resetting an IP930D handset from the Diagnostics & 
Monitoring / Status / IP Phones page; resetting a handset also resets the base that is hosting the 
handset and therefore impacts all of the handsets used by that base. Calls in progress will be dropped. 
It is recommended that you instead use ShoreTel IP930D Manager to reset handsets and bases; in 
ShoreTel IP930D Manager, you can easily see if these components are in use before resetting them. 
Navigate to the Current Status page in ShoreTel IP930D Manager and look at the “Number of Active 
Handsets (on a call).”

Understanding Configuration Parameters

The table below describes configuration parameters and default values.

Parameter Value Type Value Sources Default

2833PayType 96-127, “dynamic” If a fixed value is chosen, that value should be used in 
SDP offers for the 2833 payload type. If “dynamic” is 
chosen, the current dynamically allocated payload type 
logic should be used.

CFG 102

5004Enable Up to 1 ASCII 
character

This enables or disables the special Shoretel use of port 
5004 for RTP traffic.
0=Disable
1=Enable

CFG, 
MGCP

1

8021xEnable Up to 1 ASCII 
character

802.1x authentication is enabled is set to 1 and disabled 
if set to 0.

MAN 1

802.1xPwd Up to 255 ASCII 
Characters

String that is displayed when the handset prompts for 
the 802.1x authentication password. Characters in this 
string must be specified using UTF-8.

CFG “PWD:”
“Speaker= <- 
#=OK”

 802.1xSid Up to 255 ASCII 
Characters

String that is displayed when the handset prompts for 
the 802.1x authentication supplicant ID. Characters in 
this string must be specified using UTF-8.

CFG “802.1x Startup 
Error…..”
“-802.1x 
Aborted…..”
“802.1x 
Authenticating…”
“Seconds”
“-Failed- 
Restarting”

AmPm Up to 32 ASCII 
Characters

String used to localize the AM/PM text in the date. 
Characters in this string must be specified using UTF-8. 

CFG “am”
“pm”

AppName Up to 32 alphanumeric 
characters

This is the name of the application image that is in the 
base. The application file name can be at most 24 
characters long. The combination of filename and path 
can be up to 32 characters long. A new application 
name is specified in a configuration file and is checked 
against the NV value to decide if a new version needs to 
be downloaded. The NV value is updated after a 
successful download and flash programming sequence.

CFG Value from factory 
in NV Storage
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BackLight 1-255 Number of seconds the backlight remains on at full 
brightness when the handset is idle.

CFG 20

BackLightDim 0-255 Number of additional seconds the backlight remains on 
at a DIM level after the BackLight interval has passed 
since an idle state was entered. 

CFG 20

BackLightSave 0 or 1 If set to 1 then line status updates on the handset will 
NOT turn on the handset backlight.

CFG 0

BootName Up to 32 alphanumeric 
characters

This is the name of the boot image that is in the base. 
The boot file name can be at most 24 characters long. 
The combination of filename and path can be up to 32 
characters long. A new boot name is specified in a 
configuration file and is checked against the NV value to 
decide if a new version needs to be downloaded. The 
NV value is updated after a successful download and 
flash programming sequence.

CFG Value from factory 
in NV Storage

Country Up to 3 ASCII 
Characters

This parameter specifies the Country that is used by the 
Include parameter to identify a particular file to include. 
May be between 1 and 255.

SSON, 
CFG, MAN

1

DaysOfWeek Up to 64 ASCII 
Characters

Comma separated list of the day of week abbreviations 
used by the S1 phone to display the time. First day is 
Sunday.

CFG Sun,Mon,Tue,
Wed,Thu,Fri,Sat

DectAutoSync Yes or No Enable or disable auto synchronization of the base 
radios in a multicell system. Manual configuration is 
required if set to No.

CFG “Yes”

DectBaseAppName Up to 32 alphanumeric 
characters

This is the name of the DECT processor application 
image that is in the base. The application file name can 
be at most 24 characters long. The combination of 
filename and path can be up to 32 characters long. A 
new application name is specified in a configuration file 
and is checked against the NV value to decide if a new 
version needs to be downloaded. The NV value is 
updated after a successful download and flash 
programming sequence.

CFG Value from factory 
in NV Storage

DectBaseMac Comma separated list 
of up to 32 MAC 
addresses in hex

Comma separated list of up to 32 Base MAC addresses 
that are in the system. The index of this list (0 to 31) 
multiplied by 8 is the RPN for that base.
Example:
DectBaseMac 00087B00AA1F, 00087B00AA12
00087B00AA1F is assigned RPN 0
00087B00AA12 is assigned RPN 8

CFG “”

DectBaseName Up to 32 alphanumeric 
characters

User friendly name for identifying the base. CFG "Primary Base"

DectBaseNetworking Multicast Specify the type of networking the bases will use to 
communicate with each other. All bases on a system 
must be set identically. Multicast requires bases to be on 
the same subnet or intermediate routers to have IGMP 
V2 implemented.

CFG “multicast”

DectBasePrimary IP Address in dotted 
decimal format

IP address of the Network Primary Base. This is the 
base to which all bases will communicate to synchronize 
behavior. All bases in a system must use the same 
DectBasePrimary.

CFG “0.0.0.0”

Parameter Value Type Value Sources Default
62 Planning and Installation Guide ShoreTel IP Phone 930D



Reference Material Understanding Configuration Parameters5
DectBaseSyncSrcRpn Comma separated list 
of up to 32 decimal or 
hex RPN values 
between 0 and 255

Comma separated list of up to 32 RPN values that 
assigns the synchronization source to each repeater in 
the DectBaseMac list.
Example:
DectBaseSyncSrcRpn 0x0, 0x8

CFG 0x0

DectCallProgLevelDb -128 to 0 Set the audio level of call progress tones on the 
handset.

CFG -27

DectCancel Up to 64 ASCII 
Characters

String that is displayed on a softkey to cancel the current 
operation. Must be 6 characters or less. This must 
exactly match the systems string softkey assignment for 
the active language. Characters in this string must be 
specified using UTF-8.

CFG “Cancel”

DectCountry Up to 32 alphanumeric 
characters

This parameter specifies the country for localizing call 
progress tones. Available countries are: Germany, 
Luxembourg, France, Italy, Holland, Greece, Ireland, 
Sweden, Spain, Denmark, Finland, Turkey, Switzerland, 
Portugal, Belgium, Austria, United Kingdom, Norway, 
US, Australia, New Zealand

CFG “US”

DectDateTimeFormat Up to 64 ASCII 
Characters

Tokens are specified in the string with a preceding “\” 
character. Here are the token definitions:
d = numeric day 
D = numeric day with leading zero 
n = numeric month 
N = numeric month with leading zero 
y = numeric year two digits 
Y = numeric year four digits 
a = DaysOfWeek string 
b = MonthsOfYear string 
h = hour 
H = hour 24-hour clock with leading zero 
m = minute 
p = am/pm using AmPm parameter for localization
examples:
DateTimeFormat "\a, \b \d \Y  \h:\m\p"  = Wednesday, 
Oct 1 2008  5:50pm DateTimeFormat "\N/\D/\y \h.\m\p"  
= 5/03/08 6.22am
DateTimeFormat "\Y-\N-\D \hh\m" = 2008-05-08 6h22

CFG “\a, \b \d \Y 
\h:\m\p”

DectDial Up to 64 ASCII 
Characters

String that is displayed on a softkey to dial. Must be 6 
characters or less. This must exactly match the systems 
string softkey assignment for the active language. 
Characters in this string must be specified using UTF-8.

CFG “Dial”

DectDirectory Up to 64 ASCII 
characters

String that is displayed on the Menu screen to access 
the directory. Must be 14 characters or less. Characters 
in this string must be specified using UTF-8.

CFG “Directory”

DectDtmfLevelDb -128 to 0 Set the audio level of DTMF tones on sent to the 
network. 

CFG -16

Parameter Value Type Value Sources Default
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DectHandset Up to 256 Characters This parameter associates an IP address to a specific 
handset. This parameter may be repeated in a 
configuration file up to 4 times, once for each handset 
assigned to the bases. Two values are specified: the 
IPUI (10 characters) and IP address. IP address must be 
specified in dotted decimal notation for 3 of the 4 
handsets. One of the four handsets may use the value 
“Base” to reuse the IP address assigned to the base. 
Examples:
DectHandset 1abcdef012, Base
DectHandset 1abcdef013, 192.168.0.12
The IPUI can be found on the label underneath the 
battery on the back of the handset.

CFG “”

DectHandsetAppName Up to 32 alphanumeric 
characters

This is the name of the handset application image. The 
application file name can be at most 24 characters long. 
The combination of filename and path can be up to 32 
characters long. A new application name is specified in a 
configuration file and is checked against the NV value to 
decide if a new version needs to be downloaded. The 
NV value is updated after a successful download and 
flash programming sequence.

CFG Value from factory 
in NV Storage

DectHandsetLevelsDb Up to 255 ASCII 
Characters

Set the audio levels of the handset using a comma 
separated list of the following settings. The default 
values in decimal are listed next to the name for clarity.
TxGain   0
RxGain1 -14
RxGain2 -11
RxGain3 -8
RxGain4 -6
RxGain5 -2
RxGain6 2
Sidetone 0
It is recommended that you do not change any value by 
more than +/- 2 dB from the default values listed.

CFG Refer to "Value" 
column.

DectHeadsetLevelsDb Up to 255 ASCII 
Characters

Set the audio levels of the headset using a comma 
separated list of the following settings. The default 
values in decimal are listed next to the name for clarity.
TxGain   0
RxGain1 -3
RxGain2 0
RxGain3 3
RxGain4 6
RxGain5 9
RxGain6 12
Sidetone 0
It is recommended that you do not change any value by 
more than +/- 2 dB from the default values listed.

CFG Refer to "Value" 
column.

DectHistory Up to 64 ASCII 
Characters

String that is displayed on the Menu screen to access 
the call history. Must be 14 characters or less. 
Characters in this string must be specified using UTF-8.

CFG “Call History”

DectIntercom Up to 64 ASCII 
Characters

String that is displayed on the Menu screen to access 
the Intercom. Must be 14 characters or less. Characters 
in this string must be specified using UTF-8.

CFG “Intercom”

DectMcDebug 0, 1, 2, 3 0=none, 1=Data Sync Logging, 2=Auto DECT Tree 
Logging, 3= Data Sync and DECT Tree Logging.

CFG 0

Parameter Value Type Value Sources Default
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DectMultiCell Yes or No This parameter specifies whether or not the base is part 
of a system of more than one base or repeater.

CFG “No”

DectMultiMaster Yes or No Some manually configured base synchronization 
arrangements require more than one synchronization 
master (when a base is not within radio range, for 
example). In this case the value should be set to Yes.

CFG “No”

DectOk Up to 64 ASCII 
Characters

String that is displayed on a softkey to OK the current 
operation. Must be 6 characters or less. This must 
exactly match the systems softkey string assignment for 
the active language. Characters in this string must be 
specified using UTF-8.

CFG “Ok”

DectNbOnly 0 or 1 Limit all calls to narrowband if 1 by removing G.722 from 
SDP offers/answers.

CFG 1

DectRepeaterApp
Name

Up to 32 alphanumeric 
characters

This is the name of the repeater application image. The 
application file name can be at most 24 characters long. 
The combination of filename and path can be up to 32 
characters long. A new application name is specified in a 
configuration file and is checked against the NV value to 
decide if a new version needs to be downloaded. The 
NV value is updated after a successful download and 
flash programming sequence.

CFG “”

DectRepeaterAuto
CfgMode

Comma separated list 
of up to 100 Mode 
values 0, 1, or 2

Comma separated list of mode values that assigns the 
synchronization mode to each repeater in the 
DectRepeaterIpei list. 0=manual assignment using 
DectRepeaterSyncSrc, 1=local automatic, 2=chain 
automatic

CFG 1

DectRepeaterData
Configured

Comma separated list 
of up to 100 configured 
values 0 or 1

Comma separated list of configured state values that 
assigns the configured state to each repeater in the 
DectRepeaterIpei list. 0=not configured, 1=configured

CFG 0

DectRepeaterIpei Comma separated list 
of 4 repeater values in 
hex

Comma separated list of 4 repeater IPEIs that are 
associated with this base. Index of this list links a 
specific repeater to other repeater parameter such as 
DectRepeaterRpn. Unused repeaters use IPEI=0.
Example:
DectRepeaterIpei 005ad85dd0, 005ad85dd1,0,0,0,0,0

CFG “”

DectRepeaters Comma separated list 
of up to 4 IPUI values 
in hex

Comma separated list of up to 4 repeater IPEIs that 
associated with this base. This is used as a white list to 
limit repeater registrations and IPUI values must be 
unique to each base (no reuse).
Example:
DectRepeaters 005ad85dd0, 005ad85dd1

CFG “”

DectRepeaterRpn Comma separated list 
of up to 100 decimal or 
hex RPN values 
between 0 and 255

Comma separated list of RPN values that assigns an 
RPN value to each repeater in the DectRepeaterIpei list.
Example:
DectRepeaterRpn 0x0, 0x1

CFG 0

DectRepeaterSync
SrcRpn

Comma separated list 
of up to 100 decimal or 
hex RPN values 
between 0 and 255

Comma separated list of RPN values that assigns the 
synchronization source to each repeater in the 
DectRepeaterIpei list.
Example:
DectRepeaterSyncSrcRpn 0x0, 0x1

CFG 0

Parameter Value Type Value Sources Default
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DectRingerLevelsDb Up to 255 ASCII 
Characters

Set the audio levels of the ringer using a comma 
separated list of the following settings. The default 
values in decimal are listed next to the name for clarity.
RxGain 0 -128
RxGain1 -12
RxGain2 -8
RxGain3 -5
RxGain4 0
RxGain5 4
RxGain6  8
It is recommended that you do not change any value by 
more than +/- 2 dB from the default values listed.

CFG Refer to "Value" 
column.

DectSpeakerLevelsDb Up to 255 ASCII 
Characters

Set the audio levels of the speakerphone using a 
comma separated list of the following settings. The 
default values in decimal are listed next to the name for 
clarity.
TxGain   0
RxGain1 3
RxGain2 6
RxGain3 9
RxGain4 12
RxGain5 14
RxGain6 18
It is recommended that you do not change any value by 
more than +/- 2 dB from the default values listed.

CFG Refer to "Value" 
column.

DectSyncTime 10 to 360 Period in seconds between when the elements in the 
multicell system are synchronized.

CFG 60

DectVoiceMail Up to 64 ASCII 
Characters

String that is displayed on the Menu screen to access 
voice mail. Must be 14 characters or less. Characters in 
this string must be specified using UTF-8.

CFG “Voice Mail”

DectSysChainId 0 to 9999 This parameter identifies the ID of the System Chain that 
the base belongs to. Systems with the same ID will have 
a radio synching relationship to maximize channel 
usage.

CFG 0821

DHCP 1 ASCII Character DHCP enable/disable
0=Disabled
1=Enabled

MAN 1

DhcpCache 1 ASCII Character Enable or disable DHCP caching.
0=Disabled
1=Enabled
When the config file is processed, if set to 0 the DHCP 
cache is cleared and DHCP will not be cached again 
until enabled.

CFG 1

DscpAudio Up to 2 ASCII 
characters

Differentiated services code point for audio packets. 
Allowed values of 0 to 63. This parameter applies to all 
Layer 3 packets.

CFG, 
LLDP

0

DscpSignaling Up to 2 ASCII 
characters

Differentiated services code point for audio packets. 
Allowed values of 0 to 63. This parameter applies to all 
Layer 3 packets.

CFG, 
LLDP

0

Parameter Value Type Value Sources Default
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Ethernet1 Up to 10 ASCII 
Characters

Status of the 1st Ethernet Interface. 
Ethernet1 Status, Speed/Duplex
Where:
Status is 0 or 1 (disabled or enabled)
Speed/Duplex is one of the following:
Auto
10/FD
10/HD
100/FD
100/HD

CFG, MAN 1,Auto

FtpServers Up to 255 ASCII 
Characters

A comma separated list of up to 2 FTP servers. If a 
server is unavailable the base goes through the list until 
a working server is found.

DHCP, 
MAN

0.0.0.0

GatewayAddress Dotted Decimal ASCII Gateway address for the base. DHCP, 
MAN

0.0.0.0

IcmpArpTimeout Up to 5 ASCII 
Characters

Number of minutes before routing table entries created 
by ICMP redirects are timed out of the routing table.
If 0, then they never time out.

CFG 0

Include Up to 64 ASCII 
Characters

The file name that is specified shall be read and its 
contents included into the master configuration file. Files 
may be specified completely, or may include the 
variables $Hardware, $Country or $Language. The 
value of the Hardware Version (programmed into flash at 
the factory e.g. K01M01P01L01), Country or Language 
Parameter shall be substituted for $Hardware, $Country 
or $Language when the file name is created. For 
example:
Include "Country_$Country.txt" with the Country 
parameter set to 3 would load in the file "Country_3.txt"
This will permit parameters to be specified based on the 
Country and Language parameter values.

CFG “”

IPAddress Dotted Decimal ASCII IP address to be used by the base. DHCP, 
MAN

0.0.0.0

KeepAlive Up to 3 ASCII 
Characters

Number of seconds to wait for an audit endpoint 
command before initiating the recovery procedures in 
ShorelinePR.4.2.170. If set to zero recovery procedures 
will never be started.
Valid range is 0 to 999 seconds.

CFG 120

Language Up to 3 ASCII 
Characters

This parameter specifies the Language that is used by 
the Include parameter to identify a particular file to 
include. May be between 1 and 255.

SSON, 
CFG, MAN

1

Layer2Audio 1 ASCII character Layer 2 audio priority values from 0 to 7. CFG, 
LLDP

5

Layer2Tagging 1 ASCII character 802.1Q tagging enable on Port 1
0=Disable
1=Enable

SSON, 
CFG, 
MAN, 
LLDP

0

Layer2Signaling 1 ASCII character Layer 2 signaling priority values from 0 to 7. CFG, 
LLDP

0

LldpEnable 1 ASCII character LLDP enabled if 1 and disabled if 0. MAN 1

MaxJitter Up to 4 ASCII 
characters

The maximum value that the jitter buffer may be allowed 
to grow.  Valid values are 40 to 140 mS in 1 mS steps.

CFG 50

Parameter Value Type Value Sources Default
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MgcAuthenticate 1 ASCII character If enabled, then only authenticated MGC messages are 
accepted by the base.
0=disable,
1=enable

CFG 0

MgcpBackoffEnable 0 or 1 Enable or disable the advanced retransmit algorithm. If 
set to 0 the legacy behavior of retransmitting 7 times at 
100 mS intervals is used.

CFG 1

MgcpMaxRetx 1 to 10 Maximum number of unacknowledged retries before the 
handset enters the disconnected state.

CFG 4

MgcpRtoInit MgcpToMin to 1000 Initial retransmit timeout value in milliseconds. Must be 
equal or greater than MgcpToMin.

CFG 300

MgcpToMin 50 to 1000 Minimum allowable retransmit timeout in milliseconds. 
Prevents good acknowledgement algorithm from 
reducing the interval to too small of a value.

CFG 200

MgcpTsMax 1 to 10 Maximum amount of time in seconds that can elapse 
before the final retry attempt is sent before the handset 
enters the disconnected state.

CFG 5

MgcServers Up to 64 ASCII 
Characters

Comma separated list of up to 2 MGC Servers. Must be 
in dotted decimal format. 
Example:
192.168.0.1, 192.168.0.2

MAN

MonthsofYear Up to 64 ASCII 
Characters

Comma separated list of the months of the year 
abbreviations used by the handset to display the time.  
First month is January.

CFG Jan,Feb,Mar,Apr,
May,Jun,Jul,Aug,
Sep,Oct,Nov,Dec

NoSvc Up to 64 ASCII 
Characters

String that is displayed when the handset has lost 
service. Characters in this string must be specified using 
UTF-8.

CFG “No Service”

PersistantEvents Up to 255 ASCII 
Characters

Comma separated list of persistent events. Example:
L/hu,L/hd, U/kd,U/ku

CFG “”

ReqSvc Up to 64 ASCII 
Characters

String that is displayed as the handset is waiting for 
service from the switch. Characters in this string must be 
specified using UTF-8.

CFG “Requesting 
Service”

RtpBase Up to 5 ASCII 
Characters

This is the base port from which the base transmits and 
receives media.
The valid range should be an even number from 3000 to 
65408. 65408 is the highest even 16 bit number that 
allows enough headroom for the 64 RTP and 64 RTCP 
ports that are reserved when you establish an RTP base 
value. 
Given an RTP base, the base should use the next 64 
consecutive even numbers for RTP ports. If within that 
range an existing (reserved) odd or even UDP port 
number is used the base should skip over an even/odd 
pair to the next even number. So, for example, if the user 
set rtpBase to 5550 we would use 5550, 5552, 5556, 
5558, etc. In this example we skipped 5554 because 
5555 is a reserved port used by the phonectl server 
(Actually 5554 is also used and also provides a reason 
for skipping over 5554). 
If an odd number is specified, the base should use the 
next lowest even number if it fits the above limitations.

CFG 3000

RtcpEnable 0 or 1 If Enabled the base will send an RTCP report to the far 
end phone.

CFG 0

Parameter Value Type Value Sources Default
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SetupPassword 32 ASCII Characters This is the MD5 hash of the password that must be 
entered after the Mute button is pushed to enter a 
manual key command. Note that this password must be 
saved in flash after a value has been received from the 
MGC so it can be enforced on subsequent reboots. It is 
not cleared by the CLEAR command nor the clear step 
in the SETUP command.

MGCP, 
DHCP

1234

SntpServer Dotted Decimal ASCII SNTP server address in dotted decimal format. DHCP, 
CFG, MAN

0.0.0.0

SubNetMask Dotted Decimal ASCII Network Mask for the base. On boot, the base checks 
for a non-zero NV value, and if one is present it is used. 

DHCP, 
MAN

0.0.0.0

SysLogInfo Up to 32 ASCII 
Characters

IP Address, module, verbose level, facility code, and 
output device of the SysLog function. The port number 
may be optionally identified and appended to the IP 
address. The default of 514 will be used if no port is 
specified.
The module is a 32-bit integer where each bit refers to 
the debug enable/disable status from a specific software 
module. Bit assignments are:
0: “MGCC” #MGCP
1: “MCFGP” #config file parser
2: “MUSTG”  #not used 
3: “MNETC” #network configuration
4: “MUI” #DECT man machine interface
5: “MDIS” #not used - display module
6: “MPROV” #provisioning
7: “MAINT” #maintenance
8: “MRMON #not used 
9: “MFWU” #DECT firmware upgrade
10: “MVPN” #not used
11: “MM” # DECT mobility management
12: “MLCMD” #local mode
13: “MFACT” #DECT factory test
14: “MISC” #DECT miscellaneous API
15: “MEPT” #not used

CFG 0.0.0.0,0,0,0,0

Parameter Value Type Value Sources Default
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Setting Audio and Backlight Parameters

You can set audio levels for some parameters within the system: DectHandsetLevelsDb, 
DectSpeakerLevelsDb, DectRingerLevelsDb, and DectDtmfLevelDb. Recommended values are 
shown in the table in Understanding Configuration Parameters on page 61.

The parameter BackLightSave can be used to prevent the backlight from turning on when line status 
updates occur in order to preserve battery life. The Backlight and BacklightDim parameters can be 
used to adjust the length of time the display stays backlit after it is used. See Understanding 
Configuration Parameters on page 61.

Configuring Bases on a Network Secured with 802.1x

Bases that will operate on an 802.1x secured network must first be configured with an 802.1x 
supplicant ID and password from the Network Configuration page in ShoreTel IP930D Manager. This 
procedure must be performed before the bases are connected to the secured network and before 
handsets and repeaters are registered for the first time.

16: “HMTST” #hammer test
17: “MIND” #not used
18: “MKBD” #not used
19: “MLLDP” #not used
20: “MPROF” #not used
21: “MRTPT” #SRTP
22: “MAIL” #DECT mail socket interface
23: “MCC” #DECT call control
24: “MBOS” #not used
25: “MRCOV” #not in used yet
26: “MGSIG” #not used
27: “EAP” #DECT embedded access protocol
28: “module29” #not used
29: “module30” #not used
30: “module31” #not used
31: “RTXLOG” #syslog from Sitel
The verbose level indicates the level of information that 
is printed. Levels are 0 to 7. Facility code is the syslog 
facility code. The output devices are 0= serial port, 
1=syslog server.This parameter may appear multiple 
times to permit the assignment of unique logging levels 
to modules. Example:
SysLogInfo        192.168.0.51:514,0x8000000,3,21,1
Sets RTXLOG to level 3 to a syslog server at 
192.168.0.51

Version Up to 16 ASCII 
Characters

This parameter specifies the version identifier of the 
configuration file. It is then reported via the Mgt/gi signal 
request.

CFG “”

VlanId Up to 9 ASCII 
Characters

VLAN ID to be used on all packets from base.
Example: 
1234

SSON, 
CFG, 
MAN, 
LLDP

Parameter Value Type Value Sources Default
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To connect a base to an 802.1x secured network, follow this procedure:

1. Identify the supplicant ID and password that the base will use. This is usually configured into the 
RADIUS server that the Ethernet switch uses for authentication services.

2. Perform a factory reset (See Step 1 under Registering Handsets on page 32).

3. Connect the base to an unsecured PoE-enabled connection to a network with a DHCP server, 
allowing the base to receive an IP address.

4. Wait for the base to start and then open ShoreTel IP930D Manager for the base.

a. From a PC on the same subnet as the base, enter the following:

http://sd_<MAC address of base>

If this step fails, see Cannot log into a base with ShoreTel IP930D Manager on page 84.

b. Enter “admin” for the login ID and the last four digits or characters of the base MAC address 
for the password.

5. Go to the Network Configuration page in the ShoreTel IP930D Manager and enable 802.1x. Enter 
the Supplicant ID and Password assigned to this base on the secure network and save settings.

6. Unplug the base.

You can now plug the base into the secure network to register handsets and repeaters and it will 
use the configured information to authenticate with the 802.1x secured Ethernet port. Be sure to 
skip step 1 for factory clearing the base when following the steps in “Registering Handsets” or you 
will clear the supplicant ID and Password.
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CHAPTER
6. Diagnostics and
Troubleshooting

This chapter contains the following topics: 

 Tool Overview on page 73

 Common Problems on page 81

Tool Overview

The ShoreTel IP930D system has several tools that are available to assist with diagnosing and 
troubleshooting. Refer to the sections below for more information.

 ShoreTel IP930D Manager on page 74

 Phonectl/Telnet on page 77

 Syslog on page 77

 Handset Settings Menu on page 78

 Handset Service Menu on page 79

 Mute-INFO on page 80

 Base LED Indicator on page 80

 Repeater LED Indicator on page 81
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ShoreTel IP930D Manager

ShoreTel IP930D Manager provides detailed status information on all aspects of the base and attached 
handsets and repeaters. ShoreTel IP930D Manager also provides a listing of the active configuration 
that is in use by the base (Configuration page) and a snapshot of recently logged system events 
(System Log page).

The following sections contain information about ShoreTel IP930D Manager pages.

Current Status Page

From this page you can quickly check:

 Handsets registered to the base, their IPUI, IP address, MGC Server, Firmware version, and 
Update Status

 Firmware version of the base

 Configuration file version

 System time of day and up time

 Base MAC address, RFPI, and IP address

 Number of handsets active on a call

 System chain ID

Network Configuration Page

Access current network interface settings from this page (similar to what is available when using the 
Mute-SETUP procedure of a wired ShoreTel phone).

Manage Bases Page

Monitor the performance of a multicell system from this page. For multicell to work properly, all bases 
must be able to synchronize with each other over the air and over the network. From this page, you 
can verify both, as well as check many other settings.

To verify that all bases are in communication, check that each base in the list (except the base you are 
managing) shows “Connected” in the IP Status column of the Base units in System XXXX table.

To verify that all bases are synchronized over the air, check the Sync Property column. All bases 
should show either “Locked,” indicating that they are synchronized to the “Sync Source” in the column 
to the left, or “Primary,” indicating they are the primary over-the-air synchronization source.

To quickly manage another base, click its IP address in the Base units in System XXXX table.

The Repeaters on this Base table shows the repeaters connected to this base. All should display a 
status of “Present” and should show the synchronization relationships you established in the 
MAC-specific base configuration files. You can also check the software version for each repeater in 
this table.
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The Repeater reported RSSI Information (dBm) table shows the RSSI values that are being received 
by all repeaters on the base. Use this table to verify that repeaters are located within range of each 
other. RSSI levels that are too low are highlighted in red.

Use the DECT Sync Chain section to review synchronization relationships between bases and to 
ensure that the hierarchy contains no more than seven levels.

Configuration Page

The configuration page shows the actual values that the system has collected from the configuration 
files. 

By checking the configuration, you might discover typos or other errors that have occurred in the 
processing or the creation of the various configuration files used by the system.
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Here is the mapping between the configuration page parameter listing and the configuration 
parameters used in the configuration files:

%AC_CODE%: 0000
%MIN_JITTBUF_DEPTH%: 0
%MAX_JITTBUF_DEPTH%:MaxJitter/20 (20 mS per MAX_JITTBUF_DEPTH)
%BACKLIGHT_BRIGHT_TIME%: BackLight
%BACKLIGHT_DIM_TIME%: BackLightDim
%BACKLIGHT_SAVE%: BackLightSave
%HANDSET_MIC_LEVEL%: First value of DectHandsetLevelsDb
%HANDSET_SPEAKER_LEVELS%: Values 2 through 7 of DectHandsetLevelsDb 
%HANDSET_SIDETONE_LEVEL%: Value 8 of DectHandsetLevelsDb
%HEADSET_MIC_LEVEL%: First value of DectHeadsetLevelsDb
%HEADSET_SPEAKER_LEVELS%: Values 2 through 7 of DectHeadsetLevelsDb
%HEADSET_SIDETONE_LEVEL%: Value 8 of DectHeadsetLevelsDb
%SPKPHONE_MIC_LEVEL%: First value of DectSpeakertLevelsDb
%SPKPHONE_SPEAKER_LEVELS%: Values 2 through 7 of DectSpeakerLevelsDb
%DTMF_TONE_LEVEL%: DectDtmfLevelDb
%CALLPROGRESS_TONE_LEVEL%: DectCallProgLevelDb
%RINGER_LEVELS%: DectRingerLevelsDb
%DAYS_OF_WEEK%: DaysOfWeek
%MONTHS_OF_YEAR%: MonthsOfYear
%AM_PM%: AmPm
%GMT_TIME_ZONE%:(Will match value received from MGC in the Mgt/gmt signal)
%COUNTRY_VARIANT_ID%: DectCountry 
// 0x00 GERMANY, 
// 0x01 LUXEMBURG, 
// 0x02 FRANCE, 
// 0x03 ITALY, 
// 0x04 HOLLAND, 
// 0x05 GREECE, 
// 0x06 IRELAND, 
// 0x07 SWEDEN, 
// 0x08 SPAIN, 
// 0x09 DENMARK, 
// 0x0A FINLAND, 
// 0x0B TURKEY, 
// 0x0C SWISS, 
// 0x0D PORTUGAL, 
// 0x0E BELGIUM, 
// 0x0F AUSTRIA, 
// 0x10 UNITED KINGDOM, 
// 0x11 NORWAY, 
// 0x12 US, 
// 0x13 AUSTRALIA
// 0x14 NEW_ZEALAND
%LANGUAGE_ID%: Language
%NETWORK_DECT_AUTO_SYNC_TREE_CONFIG%: DectAutoSync (Yes=1, 0=No)
%NETWORK_SYNC_DEBUG_ENABLE%: DectMcDebug (0=none, 1=Data Sync, 2=Auto Dect Tree, 
3=Data Sync+Auto Dect Tree)
%NETWORK_SYNC_ENABLE%: DectMultiCell (Yes=1,No=0)
%NETWORK_SYNC_TIME%: DectSyncTime
%NETWORK_SYNC_CHAIN_ID%: DectSysChainId
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%NETWORK_SYNC_DATA_TRANSPORT%: DectBaseNetworking (multicast=0)
%NETWORK_SYNC_PRIMARY_STATIC_IP%: DectBasePrimary
%NETWORK_ALLOW_MULTI_PRIMARY%: DectMultiMaster (0=No, 1=Yes)
%NETWORK_SYNC_MAC_CHAIN%: DectBaseMac
%NETWORK_DECT_SYNC_TREE%: DectBaseSyncSrcRpn
%LOCAL_HTTP_SERVER_TEMPLATE_TITLE%: DectBaseName
%LOCAL_HTTP_SERVER_TEMPLATE_TITLE_LEN%: (length of DectBaseName)
%REPEATER_RPN%: DectRepeaterRpn
%REPEATER_SYNC_SRC_RPN%:DectRepeaterSyncSrcRpn
%REPEATER_AUTO_CONFIG_MODE%: DectRepeaterAutoCfgMode
%REPEATER_DATA_CONFIGURED%: DectRepeaterDataConfigured
%REPEATER_DECT_IPUI%:DectRepeaterIpei
%CODEC_PRIORITIES%:0,5,1,4,6

System Log Page

This web page shows the most recent events logged by the system. Modules that are logged, and their 
debug levels, are set using the SysLogInfo parameter. Refresh the web page to update the log.

Phonectl/Telnet

Phonectl is a PC-based program for ShoreTel phones that can also be used to access IP930D bases.

The primary purpose of the phonectl application is to enable the telnet port on a base station. It is run 
from the DOS shell and uses this command structure: phonectl -pw XXXX -telneton hostIP, where 
XXXX is the system password and hostIP is the IP address of the base you are accessing.

From telnet, you can access the VxWorks console and perform various diagnostic commands that are 
beyond the scope of this document. See the Phonectl documentation for details.

Syslog

Syslog can be used to capture long-running logs of events that occur in the system on a syslog server. 
These detailed logs are most useful when investigating infrequent and difficult-to-diagnose issues. The 
level of logging is fully programmable, depending on the area of interest.

The ShoreTel IP930D Configuration Tool can be used to configure the SysLogInfo parameter. The 
SysLogInfo parameter determines what information is sent to a syslog server.

1. Load the project file into the IP930D Configuration Tool. 

WARNING!

Make sure the project file is up to date and matches the installed configuration or you will cause 
the system to stop working when you apply the files it generates.
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2. Under the Options menu, select Syslog Settings. A dialogue box opens, as shown below.

3. Following the guidance provided by technical support, select the Module and error levels you 
desire and click OK.

Handset Settings Menu

Use this menu to perform a search for active bases and to review the status of the handset and base.

To access the Settings menu on a registered handset, press and hold the Menu button for more than 
three seconds to display the Settings menu. On a deregistered handset, press the Menu button one 
time (no need to hold the button down).

Use the Status menu item to display the base station software version, hardware version, IP address, 
and MAC address.

Using IP Search

From the Settings menu, you can use the IP Search menu item (visible if the handset is deregistered) 
to display a list of all bases within range, even if they are not part of the handset’s system. Accessing 
this function is a convenient way to check that all bases are running. You can also see the 
MAC address, IP address, RFPI, and RSSI of each base.

To access the IP Search functionality on either a registered or deregistered handset, enter *47* while 
the Settings menu is open. On a deregistered handset, you can alternately choose IP Search from the 
Settings menu.

The handset should always be power-cycled after using the IP Search option.
78 Planning and Installation Guide ShoreTel IP Phone 930D



Diagnostics and Troubleshooting Handset Service Menu6
Handset Service Menu

The handset Service menu is a hidden menu for accessing site survey mode and other status 
information.

To access this menu, enter *SERVICE* on the handset when the Settings menu is open. The handset 
goes into site survey mode.

Site survey mode is used primarily during installation to determine the signal strengths of nearby 
bases and repeaters, but can be used at any time to check coverage and to verify proper functioning of 
the bases and repeaters associated with the handset. Site survey mode shows all bases and 
repeaters within range and that the handset can connect to for service.

The graphic below shows the handset screen in site survey mode.

This screen shows:

 The base at RPN 0x10 has an RSSI of -39 dBm (it is a base because it is at a multiple of 0x08).

 The repeater at RPN 0x11 has an RSSI of -75 dBm.

 The repeater at RPN 0x12 has an RSSI of -75 dBm.

 Frame Errors (FE) have not been reported by the handset (PP) or base (FP). These numbers 
change dynamically.

 If a call were in progress, the DECT air interface CODEC would be displayed.

 The handset is currently connected directly to the base at RPN 0x10 (because it is listed first).

Frame errors detected
by the connected base
or repeater

RPN of other bases
or repeaters in rangeRPN of base or repeater

the handset is using 

Signal strength

Frame errors detected
by the handset

Codec in use
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Mute-INFO 

This information is displayed on the handset after Mute-INFO# is entered on an idle handset:

 Base IP address, subnet mask, and gateway

 Handset IP address

 Base Ethernet link speed

 FTP, MGC, and SNTP servers

 VLAN tagging status

 Application and boot file names

 MAC configuration filename and date

 Configuration file date

 Country and language settings

 Base and handset application versions

 Base and handset model numbers

 Base MAC address

 Handset IPUI

 Base and handset hardware version

 802.1x status

 LLDP status

Base LED Indicator

LED State Description

Off No Power.

2 Red flashes followed by Flashing Green 
(1 sec on/1 sec off)

Base is starting.

Winking Green (800 mS on/200 mS off) Base has started running but has not yet synchronized to a 
master (Multicell only).

Solid Green Unit is operating normally and is synchronized to a master.

Winking Red (800 mS on/200 mS off) No Ethernet.

Fast Flashing Red (500 mS on/500 mS off) Unit is upgrading firmware. Do not remove power.

Flashing Red/Green (1 S red/1 S green) Registration Enabled.

Solid Red Critical Error.

WARNING!

Never unplug a base while its LED indicator is flashing red or it may be permanently damaged.
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Repeater LED Indicator

Common Problems

Handset is stuck on searching screen

The base that is hosting this handset is off or has not yet synchronized to the rest of a multicell 
system

Check that the base that is hosting the handsets is active and synced. To do this, log into the base with 
ShoreTel IP930D Manager and navigate to the Manage Bases page. From there, check the status of 
the base in the table. See “Bases will not synchronize with each other” (below) if the bases are not 
synchronized.

The base is out of range or a nearby repeater is not functional

Move close to the handset’s base and check to see if the problem clears. If it does, the problem may 
be with one of the repeaters associated with the base.

Check that the repeaters associated with the base hosting the handset are all functional by logging into 
ShoreTel IP930D Manager and navigating to the Manage Bases page. From there, check that all 
repeaters associated with the hosting base are active and synchronized. If not, see “Repeater will not 
synchronize with its base” (below).

Check that the handset can see all of the base’s repeaters using the site survey mode of the handset. 
You may need to move closer to the repeaters to see them all. See Handset Service Menu on page 79.

Insufficient free DECT channels

If there are no free DECT channels available for the handset to connect to a base or repeater, the 
phone may enter the “Searching” mode. Check that channel limits for the system have not been 
exceeded and, if possible, turn off nearby interfering DECT systems or devices.

LED State Description

Off No Power.

Slow Flashing Green (400 mS on/250 mS off) Searching for FP.

Double Flashing Green (900 mS on/200 mS off/
200 mS on/200 mS off repeated)

Searching for FP in registration mode or performing 
registration procedures.

Steady Green (possibly with occasional red 
flashes)

Repeater is synchronized to its master and is operating 
properly. Red flashes indicate traffic is passing through the 
repeater.

Alternating Red/Green Flashing (200 mS red/200 
mS green)

Repeater is in recovery mode and cannot find base or RPN 
allocation error.

Steady Red Critical Error.
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Handset is deregistered

Register the handset to the base by first logging into the base using ShoreTel IP930D Manager and 
enabling registration on the Base Security page. Enable registration to one base at a time to speed the 
process. Use the registration code “0000” when registering a handset. When finished, disable 
registration to that base (registration mode will automatically become disabled after about 10 minutes).

Cannot register handset

Value of IPUI in DectHandset not set correctly

If registration fails, double-check that the IPUI of the handset is properly set in the hosting base’s 
MAC-specific configuration file in the parameter DectHandset.

Insufficient free DECT channels

If there are no free DECT channels available for the handset to connect to a base or repeater the 
phone may not be able to register with the base. Check that channel limits for the system have not 
been exceeded and, if possible, turn off nearby interfering DECT systems or devices.

Handset is stuck “Requesting Service” or displays “No 
Service”

Here are some items to check if this happens:

 Verify that the MGC server is properly configured either in a DHCP site-specific parameter or a 
configuration file’s MgcServers parameter. The value in use can be checked on the Current Status 
page in ShoreTel IP930D Manager, or by entering Mute-INFO# on the handset.

 Check that sufficient licenses are available for the handsets you are adding.

 Try using Mute-ping from the handset to ping the MGC server to see if the network connection and 
server are working.

Bases will not synchronize with each other

SNTP Server not working

If, after about 10 minutes, the bases have not synchronized, make sure that the SNTP server is 
properly configured and working for all bases by checking the current time and date reported on the 
Current Status page in ShoreTel IP930D Manager for each base in the multicell system. All bases must 
have a working SNTP server or they will be unable to synchronize properly.

IP Network Communications not working

Check that the bases in the multicell system are in IP communication with each other by verifying that 
they are reporting a “Connected” state in the Bases in System XXXX table on the Manage Bases page 
in ShoreTel IP930D Manager. If they report “Connection Lost,” there is an issue with IP connectivity 
between the bases.
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Check that all bases are operating on the same subnet by examining their IP addresses on the 
Manage Bases page in ShoreTel IP930D Manager. If they are not, multicast communications between 
bases will fail, thereby blocking communications.

Check that bases are properly configured

Double-check the configuration file settings for these parameters, which are critical for bases to 
synchronize properly: SntpServer, DectBaseMac, DectSysChainId, DectMultiCell, and DectAutoSync.

Repeater will not synchronize with its base

Configuration errors

If a repeater will not synchronize with its base, as indicated on the Manage Base page in ShoreTel 
IP930D Manager, or by the LED on the repeater flashing green or red/green, double-check these 
parameters in the MAC-specific configuration file for the base: 

 DectRepeaterAutoCfgMode

 DectRepeaterDataConfigured

 DectRepeaterIpei

 DectRepeaters

 DectRepeaterRpn

 DectRepeaterSyncSrcRpn

Signal level too low

See the Understanding Repeater RSSI Levels on page 35 for information on how to check that all 
repeaters are receiving a sufficient signal from their synchronization source.

Insufficient free DECT channels

If there are no free DECT channels available for the repeater to connect to a base or repeater the 
repeater may not be able to synchronize with a base or repeater. Check that channel limits for the 
system have not been exceeded and if possible turn off any nearby interfering DECT systems or 
devices.

Intermittent or unreliable response by the handset

Here are some items to check:

 Check that the handset’s IPUI appears in the DectHandset parameter of only one base.

 Check the signal level of the connected base or repeater by entering the site survey mode and 
checking the RSSI level of the first RPN in the list. See Handset Service Menu on page 79.

 Monitor for frame errors as reported by the site survey. If the RSSI is above -75 dBm, but there are 
frequent errors and you are connected to a repeater, the issue may be with the signal strength 
received by that repeater or any intermediate repeaters.
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Calls are dropped 

Calls may be dropped for many reasons, but a likely cause is that the communications channel to the 
handset from the base encountered too many errors or that a handoff was unsuccessful. Here are 
some items to check:

 Using the site survey mode, check that there is a greater than -75 dBm signal from at least one 
base or repeater in the area that the call drop occurred. Repeater locations may need to be 
optimized or additional repeaters added to provide sufficient coverage. See Handset Service 
Menu on page 79.

 Using the site survey mode check that all repeaters connected to the base hosting the handset 
with a dropped call are properly functioning. You may need to move closer to a repeater to see it in 
the site survey.

 See Understanding Repeater RSSI Levels on page 35 for information about ensuring that every 
repeater is receiving a sufficient signal from its synchronization source.

Cannot log into a base with ShoreTel IP930D Manager

To log into the base station, first try entering the following from a PC on the same subnet as the base:

http://sd_<MAC_Address_of_Base>

If that fails, use the IP address of the base, which can be obtained from one of the following methods 
(try these in the order listed):

 Perform a site survey on an deregistered handset by using the IP Search menu item from the 
Handset Settings menu. See Handset Settings Menu on page 78.

 Run a Mute-SETUP command on a handset has been registered to the base you are trying to 
contact. Press the Mute button on the handset, then type “SETUP” using the handset keypad.

 Check the base’s lease on the DHCP Server or make a DHCP reservation in advance for the base 
to use. Checking the list of leases on your DHCP server allows you to see the IP address used by 
the base.

 Perform a Wireshark capture of base booting. Apply a filter of “eth.addr==aa:bb:cc:dd:ee:ff” to see 
any broadcast traffic from the base with the MAC address aa:bb:cc:dd:ee:ff.

If you forget the password for a base, return the base to its factory default settings by following the 
steps below:

1. Plug the base into powered Ethernet and wait for the LED indicator to start flashing green.

2. Hold down the reset button on the back of the base for at least 10 seconds or until the LED 
indicator turns off. 

The base will restart in a factory default state. The factory default password is the last 4 characters 
of the base’s MAC address.
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A beep is heard about every 3 seconds when on a call

A debug mode for repeaters has been accidently activated. While on the call, use the site survey tool 
to detect the repeater that is in debug mode. Press the reset button on this repeater for at least 20 
seconds to turn off the beeping. See Handset Service Menu on page 79.
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APPENDIX
A.  Installation Example

This chapter contains the following topics: 

 Example Installation Overview on page 87

 Example Step 1: Plan to Assign Synchronization Sources on page 88

 Example Step 2: Gathering Unique Identifiers on page 88

 Example Step 3: Running the Configuration Tool on page 89

 Example Step 4: Generating and Saving Configuration Files on page 97

 Example Step 5: Print the Installation Summary on page 98

Example Installation Overview

This example illustrates how to use the ShoreTel IP930D Configuration Tool to install a multicell 
system.

In this example, the draft installation layout indicated a need for multiple bases and repeaters to cover 
an L-shaped site on a single floor.

Here are the components called for in this example:

 Three base stations

 Nine repeaters

 12 handsets
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Example Step 1: Plan to Assign Synchronization 
Sources

Each repeater in the IP930D system needs to be assigned a synchronization source within radio 
range.

In this example, the repeaters in Regions A and B will obtain their synchronization from the base. 
Because the repeaters in Region C are out of range of the base, they must obtain synchronization 
from the repeaters in Region B. 

Refer to the draft installation diagram below.

Example Step 2: Gathering Unique Identifiers

To prepare for the installation, gather the MAC address of each base, the IPUI of each handset, and 
the IPEI of each repeater that you plan to install.

This example uses the following identifiers:

Base MAC Addresses (See 
Rear Label)

Handset IPUIs
(See Label under battery)

Repeater IPEIs
(See Rear Label)

011049138C00 016e6003c0 016e6003b0

011049138C01 016e6003c1 016e6003b1

011049138C02 016e6003c2 016e6003b2

016e6003c3 016e6003b3

016e6003c4 016e6003b4

016e6003c5 016e6003b5

RA

B C

B

B
B

B

Repeater

Customer Premises

BaseR
R

R

R
R

R

R
R

R
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Example Step 3: Running the Configuration Tool

The next step is to run the ShoreTel IP930D Configuration Tool.

Here is the first window you see when running the tool. 

016e6003c6 016e6003b6

016e6003c7 016e6003b7

016e6003c8 016e6003b8

016e6003c9

016e6003ca

016e6003cb

Base MAC Addresses (See 
Rear Label)

Handset IPUIs
(See Label under battery)

Repeater IPEIs
(See Rear Label)
ShoreTel IP Phone 930D Planning and Installation Guide 89



Installation Example Example Step 3: Running the Configuration ToolA
Since you are starting a new project, begin by choosing File > New Project. A wizard opens that 
prompts you for all of the required information about the installation.

Enter a name for the project and choose the correct location for the installation.

Click on Next to move to the next page of the wizard.
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Installation Example Example Step 3: Running the Configuration ToolA
On this page, enter the number of repeaters per base. In this example, we have 3 repeaters per base, 
for a total of 9 repeaters.

We are installing 12 handsets and have reserved the IP addresses between 192.168.10.10 and 
192.168.10.30 (extra IP addresses have been reserved for future growth).

Finally, we are assigning a System ID of 1234. This number assignment will be used to create a 
multicast address used by the system for base-to-base communications. If multiple independent 
systems are installed on a common multicast zone, they must use different IDs. 

Click on Next to move to the next page of the wizard.

On this page, set the synchronization sources for the repeaters by region. Recall that our draft 
installation diagram requires the repeaters in Regions A and B to synchronize to the base. Repeaters 
in Region C synchronize to those in Region B. 

Make these selections as shown above and click Next.

Note

Be sure to check the multicast address for conflicts on the target network. The address is shown to 
right of the System ID field. If there is a conflict, change to a different System ID.
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Installation Example Example Step 3: Running the Configuration ToolA
On the next page, enter the MAC address for each base you are installing into the wizard.

The MAC address can be found on the back of the base.

You can give each base a unique name or you can use default names.

Tip

If you do many installations, it may be worth investing in a bar code scanner to read the MAC address 
and other identifiers into the IP930D Configuration Tool from the device you are installing. This saves 
time and can reduce data entry errors that cause system malfunctions.

MAC ad-
dress
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Installation Example Example Step 3: Running the Configuration ToolA
Click on Next to move to the next page of the wizard.

Copy the IPUI from each handset you are installing into the wizard. The IPUI may be found under the 
battery of the handset.

You can give each handset a unique name or you can use the default names.

IPUI
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Installation Example Example Step 3: Running the Configuration ToolA
Click on Next to move to the next page of the wizard.

Copy the IPEI from each repeater you are installing into the wizard. The IPEI is found on the rear of the 
repeater.

You can give each repeater a unique name or you can use the default names.

IPEI
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Installation Example Example Step 3: Running the Configuration ToolA
Click on Next to move to the next page of the wizard.

Review the data to make sure all items are completely configured. 

Click Finish and you will be prompted to save the project file to your computer. You can choose a 
unique name or use the default file name. 

Tip

It is a good idea to go back (using the Previous and Next buttons) to double-check the identifiers that 
were entered for all devices. If any are misconfigured, the system will not operate properly.
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Installation Example Example Step 3: Running the Configuration ToolA
After saving the file, this window opens:

From this window, you can customize the configuration of your system.

The window is broken into 3 panes:

 The left pane shows the system and all bases that are a part of the system. You can click on the + 
sign to expand the list and show all of the bases in the system.

 The center pane shows all of the components that make up the item that is highlighted in the left 
pane.

 The right pane shows the system properties associated with the selected item. In this case, the 
selected item is the system and only the System ID can be modified.
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Installation Example Example Step 4: Generating and Saving Configuration FilesA
Expand the list in the left pane by clicking on the + sign and then select Base1 to see this:

Because Base1 is highlighted, its properties are shown on the right pane. The properties of any device 
can be modified by highlighting that device.

Later, if you need to add, replace, or remove equipment, you will do so from this screen.

The configuration is now complete. Save the project to your computer for safe keeping and future 
reference. If you ever need to replace or add equipment you will need to start from this project file.

Example Step 4: Generating and Saving 
Configuration Files

Next, we need to generate and store the MAC-specific configuration files. 

To do this, choose “Save Configuration Files As” from the File menu in the IP930D Configuration Tool. 
Select the root directory of the ShoreTel FTP server (for example, save files to c:\inetpub\ftproot), or 
choose another location from which the files can be copied over to the FTP server later.
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Installation Example Example Step 5: Print the Installation SummaryA
Example Step 5: Print the Installation Summary

The final step is to print the installation summary. The summary provides a guide to show which 
devices need to be installed where, as well as which handsets and repeaters are associated with each 
base. To print the installation summary, select File > Print Installation Summary.

 Here is what the first part of the summary looks like for our example:

This summary identifies:

 Bases to be installed, identified by MAC address

 Repeaters to be installed per region, identified by IPEI

 Repeaters and handsets to be registered with each base
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Installation Example Example Step 5: Print the Installation SummaryA
The installation summary also provides a complete summary of the system (not shown) that includes 
RPN assignments for each base and repeater. This information can be useful when installing multiple 
bases and for troubleshooting purposes.

Print and save a copy of the installation summary to use for future reference. Repeaters must be 
installed according to this summary or the system will not function properly.
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APPENDIX
B.  Glossary

This glossary defines terms and abbreviations relevant to the ShoreTel IP930D system.

Term Definition

dBm A power level measurement that the system uses to report RSSI levels. Note 
that a -40 dBm signal is greater than a -60 dBm signal and that sometimes the 
minus sign is not used, such as when the dBm level is displayed by the site 
survey tool on a handset.

DECT Channel The combination of a timeslot and frequency for transmitting information in a 
DECT system. In the US and Canada, 12 timeslots times 5 frequencies yields 
60 available channels. Europe, Australia and New Zealand provide up to 120 
channels.

FP Fixed Part. Refers to bases and repeaters.

IPEI International Portable Equipment Identity—a unique identifier for repeaters.

IPUI International Portable Unit Identity—a unique identifier for handsets.

MGC Media Gateway Controller.

Multicell A system consisting of more than one base.

PoE Power over Ethernet (802.3af)

PP Portable Part. Refers to handsets.

RF Radio Frequencies.

RFPI Radio Fixed Part Network Identity—a unique identifier for bases.

RPN Radio Fixed Part Number—a unique number between 0-255 assigned to each 
base and repeater in a system.

RSSI Received Signal Strength Indicator.
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GlossaryB
Synchronization Source Every base or repeater must be assigned a synchronization source either 
automatically (in the case of bases) or manually (in the case of repeaters.) This 
is the source from which the base or repeater derives its clocking 
synchronization for the radio interface.

0x23 Any number starting with "0x" is in hexadecimal. 0x23 is 35 in decimal.

Term Definition
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